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Preface     xi

This Maintenance and Service Guide is a troubleshooting reference that can be used
when servicing the Compaq Armada 7800 Family of Personal Computers.

Compaq Computer Corporation reserves the right to make changes to the Compaq
Armada 7800 Family of Personal Computers without notice.

Additional information is available on the Compaq Armada 7800 Family of Personal
Computers Illustrated Parts Map. Information for the Compaq ArmadaStation and
Armada MiniStation E and EX is available in the Compaq ArmadaStation and Armada
MiniStation E and EX Maintenance and Service Guide and Illustrated Parts Map.

Symbols
The following words and symbols mark special messages throughout this guide:

! WARNING:  Text set off in this manner indicates that failure to follow
directions in the warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow
directions in the caution could result in damage to equipment or loss of
information.

IMPORTANT:  Text set off in this manner presents clarifying information or specific
instructions.

NOTE:  Text set off in this manner presents commentary, sidelights, or interesting
points of information.

Technician Notes

! WARNING:  Only authorized technicians trained by Compaq should repair
this equipment. All troubleshooting and repair procedures are detailed to
allow only subassembly/module level repair. Because of the complexity of
the individual boards and subassemblies, no one should attempt to make
repairs at the component level or to make modifications to any printed
wiring board. Improper repairs can create a safety hazard. Any indication
of component replacement or printed wiring board modifications may void
any warranty or exchange allowances.

! WARNING:  The computer is designed to be electrically grounded. To
ensure proper operation, plug the AC power cord into a properly grounded
electrical outlet only.

CAUTION:  To properly ventilate the system, you must provide at least 3
inches (7.62 cm) of clearance on the left and right sides of the computer.
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Serial Number
When requesting information or ordering spare parts, provide the computer serial
number. The serial number is on the bottom of the computer.

Locating Additional
Information

The following documentation provides information for the computer:

n Compaq Armada 7800 Family of Personal Computers documentation set

n Microsoft Windows 95/Windows NT 4.0 User’s Guide

n Compaq Service Training Guides

n Compaq Service Advisories and Bulletins

n Compaq QuickFind

n Compaq Service Quick Reference Guide

n Compaq Armada 7800 Family of Personal Computers Maintenance and Service Guide

n Compaq Armada 7800 Family of Personal Computers Illustrated Parts Map

n Compaq ArmadaStation and Armada MiniStation E and EX Maintenance and Service Guide

n Compaq ArmadaStation and Armada MiniStation E and EX Illustrated Parts Map

n Compaq Internet site at http://www.Compaq.com
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Product Description

1.1  Computer Features and Models

The Compaq Armada 7800 Family of Personal Computers offers advanced modularity,
an Intel Pentium II processor with 64-bit architecture, an industry-leading Accelerated
Graphics Port (AGP) implementation, and extensive multimedia support. The computer
provides desktop functionality and connectivity through the optional ArmadaStation
and Armada MiniStation.

Figure 1-1.  Compaq Armada 7800 Personal Computer

Features

The computer has the following standard features:

■ Intel 266-MHz Pentium II processor with 64-bit architecture, MMX technology, and
512-KB, level-2 cache memory

■ Industry-leading portable computer AGP implementation, featuring:

- 66-MHz dedicated graphics bus

- frame made AGP

■ 4-MB SGRAM (synchronous graphics)
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■ 64-MB of SDRAM (synchronous):  32-MB on system board, 32-MB in memory
expansion compartment; expandable to 160 megabytes

■ Upgradable flash ROM BIOS

■ 13.3 XGA (1024 × 768) TFT color display, true color (24-bit) support

■ Keyboard with built-in EasyPoint III pointing device and mouse buttons

■ Lithium ion (Li-ion) battery pack

■ Removable 5.0-GB hard drive

■ MultiBay that supports a CD-ROM drive, a second hard drive, a second battery pack,
or a diskette drive

■ Two PC Card slots that accept 32- and 16-bit Type I, II, and III PC Cards, with
zoomed video interface in the bottom slot

■ IrDa-compliant infrared port1 (4-Mbps standard) for wireless file transfer, printing,
and file synchronization

■ Built-in stereo speakers providing Compaq PremierSound, microphone, and jacks for
stereo audio sound with electronic equalization and wave table synthesis

■ Energy Star-compliant power saving features

■ Ports and connectors for external equipment, including universal serial bus (USB),
serial, parallel, external monitor, and PS/2-compatible pointing device or keyboard

■ Security features

■ Desktop functionality available with the optional Compaq ArmadaStation and
Armada MiniStation

■ Domestic and international modem and Ethernet connectivity

■ Integrated AC Adapter

■ Integrated 33.6-Kbps data/fax modem

                                                         
1 IrDa 4MB compliant. Infrared performance may vary depending on performance of infrared peripherals, distance
between infrared devices, and applications used.
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Models

The Armada 7800 models are shown in Table 1-1. The computer model designation is
composed of a group of characters that define each model’s characteristics.

Table 1-1
Models and Model Naming Convention

Compaq Armada 7800 Family of Personal Computers
Model
Armada 7800  6266  T  5000  D  M 1 (64-MB RAM standard)

Armada 7800  6266  T  5000  D  0  1 (64-MB RAM standard)

Armada 7800  6266  T  5000  D  0  3 (64-MB RAM standard)

Armada 7800 7 8 0 0 6 266 T 5000 D M 1
Key A B C D E F G H I

Key Description Options

A Line designator 7 = Performance

B Family designator 8 = Armada 7800

C Processor type 6 = Intel Pentium II processor with MMX technology

D Processor speed 266 = 266-MHz processor

E Panel type T = 13.3-inch XGA TFT 1024 × 768

F Hard drive capacity 5000 = 5.0 GB

G Drive type D = 20X Max CD-ROM
V = DVD
0 = none

H Modem M = Integrated modem
0 = No integrated modem

I Operating system &
software version

0 = No operating system
1 = Windows 95
2 = Windows 98
3 = Windows NT 4.0
4 = Windows NT 5.0
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Intelligent Manageability

Intelligent Manageability consists of preinstalled software tools for the computer and
Compaq servers that assist in tracking, troubleshooting, protecting, and maintaining the
computer. It provides the following functions:

■ Asset Management—provides detailed configuration and diagnostic information.

■ Fault Management—prevents, predicts, and alerts of impending hardware problems.

■ Security Management—protects against unauthorized access to data and
components.

■ Integration Management—uses industry-standard technologies such as DMI and
SNMP to integrate with PC management software providers.

■ Configuration Management—optimizes the computer by providing the latest drivers,
utilities, and software, which are available on CD-ROM and the Compaq web site at
http://www.compaq.com.

NOTE:  For further help with Intelligent Manageability, refer to Intelligent
Manageability Help. Click Start ⇒ Compaq Information Center ⇒ double-click
Intelligent Manageability Help.

Asset Management

AssetControl retrieves component information when on the road or connected to the
network.

AssetControl also enables the network administrator to remotely retrieve information
from any Compaq computer connected to the network. The information can be used to
assist in tracking and maintaining the computer and its components. It provides the
following information:

■ Inventory information—The network administrator can retrieve information about
the computer over the network by using Compaq Insight Manager or any PC
management tool provided by Compaq Solution Partners. AssetControl information
retrieved from the computer includes:

❑ Manufacturer, model, and serial number of Compaq computers, monitors, hard
drives, battery packs, memory boards, processor speeds, and operating systems.

❑ Asset tag

❑ System board and ROM revision levels

❑ BIOS settings

■ Diagnostic information—Diagnostics for Windows includes the information on hard
drives, ports, and video, sound, and other components. Compaq Diagnostics for
Windows can be accessed by clicking Start ⇒ Programs ⇒ Compaq Utilities ⇒
Compaq Diagnostics.

All of the above information can be viewed, printed, or saved.
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Changing the Asset Tag Number
1. Turn on or restart the computer.

2. Press F10 when the cursor appears in the upper right corner of the screen.

3. Select Computer Setup ⇒ Intelligent Manageability.

4. Follow the instructions on the screen.

Fault Management

The Fault Management features minimize downtime and data loss by monitoring
system performance and generating the following alerts:

■ Hard drive alert—provides warning up to 72 hours in advance of impending hard
drive problems and can automatically start optional backup software.

■ System temperature alert—reports overheating. As the system temperature rises, this
feature first adjusts fan speed and other cooling components, then displays an alert,
then shuts down the system.

■ Battery pack alert—reports charging problems and battery pack failure.

■ Monitor alert—diagnoses and displays external monitor operational problems.

■ Memory alert—reports memory board configuration changes when a memory board
is removed, added, or reconfigured. It also provides the previous and current
configurations for comparison.

The alerts work with or without network connection. Of course, if the computer is not
connected to the network, the network administrator cannot receive alerts from the
computer.

Fault Management Alerts

Alerts can be enabled, disabled, and tested, and software can be set to back up
information whenever a hard drive alert occurs.

■ While the computer is connected to a network, alerts appear on the computer display
and are simultaneously reported to the network console.

NOTE:  A battery charging problem alert is reported only on the computer display.

■ When the computer is not connected to a network, the user will receive a local alert.

To set alerts, double-click the Intelligent Manageability icon.
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Security Management Overview

Security Management features customize system security.

■ Power-On and Setup Passwords—prevent unauthorized access to your information
and computer configuration.

■ DriveLock—prevents access to hard drives.

■ Device disabling—prevents unauthorized data transfer through modems, serial ports,
parallel ports, and infrared ports on the computer and an optional docking station.

■ QuickLock/QuickBlank—locks the keyboard and clears the screen.

■ Ownership Tag—displays ownership information during system restart.

Configuration Management

Configuration Management optimizes software upgrade and customer support
procedures. Compaq provides support software to optimize the performance of the
computer. This support software is accessible through a monthly subscription
CD-ROM. Support software can also be downloaded from the Compaq web site at
http://www.compaq.com. Support software includes:

■ Locator browser—searches for the latest device drivers, utilities, ROM images, and
other support software on a CD-ROM and at the Compaq web site at
http://www.compaq.com.

■ Decision Support—provides detailed information about drivers, utilities, and
software available on the computer. The information includes descriptions, features,
enhancements, dependencies, and necessary upgrades.

■ InfoMessenger—provides notifications by email when support software for the
computer becomes available.
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1.2  Computer Components

The following table lists the components that ship with the computer and those that are
available as options. All components are available as spare parts. For more information
about ordering components, refer to Chapter 3, “Illustrated Parts Catalog.”

Table 1-2
Component Availability

Component Ships with Computer Available as Option

Battery pack ■ ■

Modem (not available in all locations) ■

Modem cable (country specific) ■ ■

Diskette drive ■

MultiBay weight saver ■

Slip case (shipped with computer only in
Europe, Middle East, and Africa)

■

EasyPoint III caps ■

Telephone cable (country specific) ■

Power cable ■

3-prong to 2-prong converter (Japan only) ■

Quck Restore CD-ROM ■

Security kit ■

ArmadaStation ■

Armada MiniStation E and EX ■

Memory expansion board ■

Battery charger ■

Automobile/aircraft adapter ■

Headset ■

Hard Drive MultiBay Adapter ■

20X CD-ROM drive ■ ■

5.0-GB hard drive ■ ■
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The computer options are described in the following sections.

System Memory Options

The main memory subsystem supports a minimum standard 32 megabytes of
Synchronous SDRAM, expandable to 160 megabytes. The minimum standard
Synchronous SDRAM is integrated on the system board. The upgrade SDRAM is
accomplished with memory expansion boards that are available in 16-, 32-, and 64-
megabytes.

The memory expansion slot cover is secured to the computer by a Torx T-8 screw. A
tamper-resistant security screw, included with the computer, can be used to provide
added security. The security wrench, also included with the computer, must be used to
remove the tamper-resistant security screw.

System memory can be upgraded as shown in Table 1-3.

Table 1-3
Memory Upgrade

Base Memory on System Board Memory Expansion Board Total Memory

32 MB   16 MB (1 × 16 MB)   48 MB

32 MB   32 MB (2 × 16 MB or 1 × 32 MB)   64 MB

32 MB   48 MB (1 × 16 MB + 1 × 32 MB)   80 MB

32 MB   64 MB (2 × 32 MB or 1 × 64 MB)   96 MB

32 MB   80 MB (1 × 16 MB + 1 × 64 MB) 112 MB

32 MB   96 MB (1 × 32 MB + 1 × 64 MB) 128 MB

32 MB 128 MB (2 × 64 MB) 160 MB

The computer is shipped with 32-MB of memory on the system board and 32-MB in the memory expansion
compartment.
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Mass Storage Devices

The following mass storage devices are available for the computer.

Table 1-4
Mass Storage Devices

Device Dimensions

Diskette drive 3.5-inch, 1.44-MB

Hard drive 5.0-GB (also available as an option)

CD-ROM drive 20-Speed Max (also available as an option)

LS-120 external
diskette drive

120-MB

Diskette Drive
The computer uses a 3.5-inch diskette drive that fits into the computer, ArmadaStation,
or Armada MiniStation EX MultiBays. The diskette drive is a three-mode type that is
compatible with 1.44 Megabytes, 1.2 Megabytes, and 720 Kilobytes (formatted) AT
drive types. The system supports a maximum of two diskette drives: one in the
computer MultiBay and one in the ArmadaStation or Armada MiniStation EX
MultiBay.

Hard Drive
The dedicated hard drive bay supports a removable 5.0-GB hard drive and the MultiBay
supports a second hard drive. Before a hard drive can be used in the MultiBay, it first
must be inserted in the Hard Drive MultiBay Adapter.
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CD-ROM Drive

A 20-Speed Max CD-ROM drive comes as standard equipment with the computer. This
CD-ROM drive is also available as an option. The drive supports 3.5-inch and 5.25-inch
media in the following formats:

■ ISO-9660, the most common CD-ROM format

■ CD-ROM XA eXtended Architecture, a standard for storing multimedia information

■ Photo CD (single and multisession), Kodak's format for storing photographic images
on CD-ROM

■ CD-i and CD-i Bridge

■ CD-DA (digital audio)

■ CD-ROM Mode 1 and Mode 2

■ CD-I Mode 2 (Form 1 and Form 2)

■ Video CD
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Battery Equipment Options

The following battery options are available:

■ Automobile/Aircraft Adapter

■ Lithium ion battery pack

■ Battery Charger

Automobile/Aircraft Adapter

The Automobile/Aircraft Adapter allows the computer to operate from a 12-volt aircraft
DC socket and from an automobile cigarette lighter receptacle.

Lithium Ion Battery Pack

The battery pack can be used in the computer dedicated battery bay, computer
MultiBay, ArmadaStation MultiBays, and Armada MiniStation EX MultiBay and
battery charging bay.

Battery Charger

The external Battery Charger has the following features:

■ Two battery charging bays

■ Charging of one battery in 1.5 hours

■ Charging of two batteries in 3 hours
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1.3  Computer External Components
The external components on the display, front, and left side of the computer are shown
in Figure 1-2 and described in Table 1-5.

Figure 1-2.  Display, Front, and Left Side Components

Table 1-5
Display, Front, and Left Side Components

Item Component Function

  1 Display release latch Opens the computer.

  2 Mono Microphone Allows for audio input; located on the inside and outside of the
display, can be used whether the computer is open or closed.

  3 Stereo speakers (2) Produce high-quality stereo sound.

  4 Tilt feet (2) Tilt the computer for ease of use.

  5 Fan Provides airflow exhaust.

  6 Battery bay Accepts Lithium ion battery pack.

  7 Hard drive bay Accepts removable hard drive.

  8 MultiBay Accepts MultiBay devices: CD-ROM drive, diskette drive, hard
drive (in Hard Drive MultiBay Adapter), LS-120 MultiBay Drive,
battery pack.
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The external components on the right side of the computer are shown in Figure 1-3 and
are described in Table 1-6.

Figure 1-3.  Right Side Components

Table 1-6
Right Side Components

Item Component Function

  1 Security slot Secures the computer to a fixed object to prevent theft.

  2 PC Card eject levers (2) Eject PC Cards from the slots.

  3 PC Card slots Accepts 16- and 32-bit CardBus PC Cards.

  4 25-pin modem connector Connects a country-specific 25-pin telephone cable (all
countries except North America, Latin America, Japan, China,
and Hong Kong).

Also connects a cellular phone to the computer (U.S. only).
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The external components on the rear panel of the computer are shown in Figure 1-4 and
are described in Table 1-7.

Figure 1-4.  Rear Panel Components

Table 1-7
Rear Panel Components

Item Component Function

  1 Universal serial bus (USB)
connector

Connects USB devices, such as cameras for video conferencing,
or hubs which connect multiple USB devices.

The USB connector is a powered hub. When running Windows
95 or higher or Windows NT or higher, any combination of up to
five powered or unpowered hubs can be connected in any
sequence, as long as two unpowered hubs are not connected
next to each other.

When running a lower version of Windows or Windows NT, or if
using a different operating system, up to two hubs can be
connected.

  2 Mono microphone jack Connects mono microphone, disabling the built-in microphone.

  3 Stereo speaker/headphone jack Connects external stereo speakers, headphones, or headset.

This jack is driven by an amplifier and has volume control. The
internal computer speakers are turned off when external
speakers or headphones are plugged into this jack.

  4 Stereo line-in jack Connects external device such as a CD player, tuner, or tape
deck.

Continued
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Table 1-7  Continued

  5 Power cord connector Connects external (AC) power.

  6 RJ-11 modem jack Connects a standard telephone cable for a modem in North
America, Latin America, Japan, China, and Hong Kong only.

  7 Infrared port Provides wireless communication between the computer and
another infrared-equipped device using an infrared beam.

  8 Serial connector Connects optional serial devices such as a mouse.

  9 Parallel connector Connects optional parallel devices such as a printer.

10 Docking connector Connects optional ArmadaStation or Armada MiniStation E or EX.

11 Keyboard/mouse connector Connects an optional full-sized keyboard or a mouse. Both
external mouse and computer pointing device are active. An
optional splitter/adapter allows both an external keyboard and
mouse to be used at the same time.

12 External monitor connector Connects an optional external monitor. Also connects a
television adapter.
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Computer keyboard components are shown in Figure 1-5 and described in Table 1-8.

Figure 1-5.  Computer Components:  Keyboard

Table 1-8
Keyboard Components

Item Component Function

  1 Display switch Turns off the display if it is closed while the computer is turned
on. The computer beeps unless audio has been disabled.

  2 Vents Allows airflow to cool the computer.

  3 Suspend button Toggles on to initiate or off to exit Suspend.

  4 Volume control Adjusts volume of stereo speakers.

  5 Power switch Turns computer on or off.

  6 Scroll lock key Turns on the scroll function.

  7 Page up and page down keys Moves image to previous or following screen.

  8 Num Lk key Turns on the numeric lock function.

  9 Embedded numeric keypad Converts keys to numeric keypad.

10 Cursor-control keys Moves the cursor around the screen.

11 Fn key Used with hotkeys to perform preset hotkey functions.

12 Caps lock key Turns on the caps lock function.

13 F1 through F12 function keys Perform preset functions.

14 Programmable keys Assign and launch frequently used documents or applications
and emulate Windows and Application Logo Keys.
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Additional computer keyboard components are shown in Figure 1-6 and described in
Table 1-9.

Figure 1-6.  Keyboard Components (continued)

Table 1-9
Keyboard Components (continued)

Item Component Function

  1 Power/suspend light (green) Turns on when computer is turned on; blinks in Suspend; turns
off when computer is in Hibernation or turned off.

  2 Battery power light (orange) Turns on when a battery pack in the battery bay is charging or
waiting to charge. Turns off when battery pack is fully charged.
Blinks 6 times if low-battery condition is reached. Blinks
continuously if critical low-battery condition is reached. If AC
power is not connected within 20 seconds, Hibernation is
initiated (unless Hibernation has been disabled).

  3 Hard drive light (green) Turns on when the hard drive is being accessed.

  4 MultiBay drive light (green) Turns on when the MultiBay device is being accessed or when a
battery pack in the MultiBay is charging or waiting to be
charged.

  5 Left and right mouse buttons Function like left and right mouse buttons on an external mouse.

  6 EasyPoint III pointing device Moves the cursor across the screen.

  7 Caps lock light Turns on when the Caps Lock function is on.

  8 Scroll lock light Turns on when Scroll function is on.

  9 Numeric lock light Turns on when the Numeric Lock function is on.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

1-18 Product Description

The external components on the bottom of the computer are shown in Figure 1-7 and
are described in Table 1-10.

Figure 1-7.  Bottom Components

Table 1-10
Bottom Components

Item Component Function

  1 Battery release latch Releases the battery from the battery bay.

  2 Hard drive release latch Releases the hard drive from the hard drive bay.

  3 Docking restraint latch recess Secures the computer to the ArmadaStation.

  4 Hard drive/MultiBay security
screw slot

Allows hard drives and MultiBay devices to be secured inside the
computer using the single and dual bay security screws.

  5 MultiBay release latch Releases devices from the MultiBay.

  6 Memory expansion slot cover Covers the memory expansion compartment.

  7 Labels area Contains labels that describe the computer model and provide
agency and modem information.

  8 Serial number Numerical identification for the computer.
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1.4  Design Overview

This section presents a design overview of key parts and features of the computer. For
assembly/disassembly instructions for the parts described in this section, refer to
Chapter 5.

System Board

The system board provides the following device connections:

■ Memory expansion board

■ Diskette drive

■ Hard drive

■ CD-ROM drive

■ Display

■ Keyboard/EasyPoint III pointing device

■ Audio

■ Pentium II processor

■ Fan

■ PC Cards

■ Modem

The computer is equipped with a 3.1-volt, Intel Mobile Pentium II 266-MHz processor.
For ventilation, an electrical fan is installed. The fan operates on from 5 to 12 volts and
is controlled by a temperature sensor. The fan is designed to turn on automatically when
high temperature conditions exist. These conditions are affected by high external
temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software applications. Exhaust air is displaced
through the ventilation grill located on the left side of the computer.

CAUTION:  To properly ventilate the computer, allow at least a 3-inch (7.6 cm) clearance
on the left and right sides of the computer.
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Troubleshooting
Follow these basic steps when beginning the troubleshooting process:

1. Complete the preliminary steps listed in Section 2.1.

2. Run the Power-On Self-Test (POST) as described in Section 2.3.

3. Run Computer Setup as described in Section 2.5.

4. Run the Computer Checkup (TEST) as described in Section 2.6.

5. If you are unable to run POST or Computer Checkup or if the problem persists after
running POST and Computer Checkup, perform the recommended actions
described in the diagnostic tables in Section 2.5.

Follow these guidelines when troubleshooting:

■ Complete the recommended actions in the order in which they are given.

■ Repeat POST and Computer Checkup after each recommended action until the
problem is resolved and the error message does not return.

■ When the problem is resolved, stop performing the troubleshooting steps and do not
complete the remaining recommended actions.

■ Refer to Chapter 5 for removal and replacement procedures that are recommended.

■ If the problem is intermittent, check the computer several times to verify that the
problem is solved.

The following table describes the troubleshooting actions:

If You Want To: Then Run:

Check for POST error messages POST

Check that computer components are recognized and
running properly

Computer Checkup (TEST) under Compaq Utilities

View information about the computer and installed or
connected devices

View System Information (INSPECT) under
Compaq Utilities

Perform any of the following:
■ Check the system configuration
■ Set the system power management parameters
■ Return the system to its original configuration
■ Check system configuration of installed devices

Computer Setup
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2.1  Preliminary Steps

IMPORTANT:  Use AC power when running POST, Computer Setup, or Computer
Checkup. A low battery condition could initiate Hibernation and interrupt the test.

Before running POST and Computer Checkup, complete the following steps:

1. Obtain established passwords. If you must clear the passwords, go to Section 2.2.

2. Ensure that the hard drive is installed in the computer.

3. Ensure that the battery pack is installed in the computer and the power cord is
connected to the computer and plugged into an AC power source.

4. Turn on the computer.

5. If a power-on password has been established, type the password and press Enter.

6. Run Computer Setup (Section 2.5). If a Setup password has been established, type
the password and press Enter.

7. Turn off the computer and all external devices.

8. Disconnect external devices that you do not want to test. If you want to use the
printer to log error messages, leave it connected to the computer.

NOTE:  If a problem only occurs when an external device is connected to the computer,
the problem could be with the external device or its cable. Isolate the problem by
running POST with and without the external device connected.

9. Use Compaq Utilities and loopback plugs in the serial and parallel connectors if you
plan to test these ports.

Follow these steps to run Compaq Utilities:

a. If you are running Compaq Utilities from the hard drive, turn on or restart the
computer. Press F10 when the cursor appears in the upper-right corner of the
screen. If you do not press F10 in time, restart the computer and try again.

If you are running Compaq Utilities from diskette, insert the Compaq Utilities
diskette in drive A. Turn on or restart the computer.

b. Press Enter to accept OK.

c. Select Computer Checkup (TEST).

d. Select Prompted Diagnostics.

e. After “Identifying System Hardware” completes, select Interactive Testing and
follow the instructions on the screen.
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2.2  Clearing Passwords
1. Turn off the computer.

2. Disconnect the power cord (refer to Section 5.4).

3. Remove the battery pack (Section 5.7).

4. Remove the keyboard (Section 5.11).

5. Remove the audio/USB board (Section 5.14).

6. Remove the modem board (Section 5.15).

7. Remove the audio assembly bracket (Section 5.16).

8. Remove the lithium disc cell battery (Section 5.17).

9. Disconnect the auxiliary battery (Section 5.19).

10. Allow the computer to set for five minutes.

11. Reconnect the auxiliary battery.

12. Install the lithium disc cell battery.

13. Install the audio assembly bracket, modem board, audio/USB board, and keyboard.

14. Reconnect the power cord. Do not reinstall the battery pack yet.

15. Turn on the computer.

NOTE:  Remember to set the date and time the next time the computer is turned on.
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2.3  Power-On Self-Test (POST)

The Power-On Self-Test (POST) is a series of tests that run every time the computer is
turned on. POST verifies that the system is configured and functioning properly.

To run POST, complete the following steps:

1. Complete the preliminary steps (Section 2.1).

2. Turn on the computer.

If POST does not detect any errors, the computer beeps once or twice to indicate that
POST has run successfully. The computer boots from the hard drive or from a bootable
diskette if one is installed in the diskette drive.

2.4  POST Error Messages

If the system is not functioning well enough to run POST, or if the display is not
functioning well enough to show POST error messages, refer to the Troubleshooting
tables in Section 2.7.

If POST detects an error, one of the following events occurs:

■ A message with the prefix "WARNING" appears, informing you where the error
occurred. The system pauses until you press F1 to continue.

■ A message with the prefix "FATAL" appears, informing you where the error
occurred. After the message, the system emits a series of beeps, then stops.

■ The system emits a series of beeps, then stops.

Warning messages indicate that a potential problem, such as a system configuration
error, exists. When F1 is pressed, the system should resume. You should be able to
correct problems that produce WARNING messages.

IMPORTANT:  When a WARNING message includes the prompt to "RUN SCU," press
F10 to run Computer Setup. (Computer Setup replaces the SCU utility.)
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If you receive one of the error messages listed below, follow the recommended action.

Table 2-1
Warning Messages

Message Description Recommended Action

CMOS checksum invalid, run SCU CMOS RAM information has
been corrupted.

Run Computer Setup to reinitialize
CMOS-RAM.

CMOS failure, run SCU CMOS RAM has lost power. Run Computer Setup to reinitialize
CMOS-RAM.

Diskette controller error The diskette drive controller
failed to respond to the
recalibrate command.

If there is no diskette drive in the
system, run Computer Setup to
properly configure the CMOS-RAM to
show no diskette drive present. If the
problem persists, or if a diskette drive
is present, complete these steps until
the problems is solved:

1. Check diskette drive connections.
2. Replace diskette drive.
3. Replace system board.

Diskette track 0 failed The diskette drive cannot read
track 0 of the diskette in the
drive.

Try another diskette. If the problem
persists, you may need to replace the
diskette drive.

Hard disk controller error The hard drive controller failed
to respond to the reset
command.

Check the drive parameters. Turn off
the system and check all related
connections.

Keyboard controller failure The keyboard failed the self-test
command.

Replace the system board.

Keyboard failure The keyboard failed to respond
to the RESET ID command.

Replace the keyboard. If the problem
persists, replace the system board.

No interrupts from Timer 0 The periodic timer interrupt is
not occurring.

Replace the system board.

ROM at xxxx (LENGTH yyyy) with
nonzero checksum (zz)

An illegal adapter ROM was
located at the specified address.

Check the external adapter (such as a
video card) to determine if it is causing
the conflict.

Time/Date corrupt - run SCU The time and date stored in the
real time clock have been
corrupted, possibly by a power
loss.

1. Run Computer Setup.
2. If problem persists, replace

auxiliary battery.
3. If problems persists, replace system

board.

Hard disk xx failure (or error) A failure or an error occurred
when trying to access the hard
drive.

1. Run Scan disk.
2. Check disk in DOS and

Windows 95. If problem persists,
refer to Table 2-10.
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Fatal errors emit a beep and may display a FATAL message. Fatal errors indicate severe
problems, such as a hardware failure. Fatal errors do not allow the system to resume.
Some of the Fatal error beep codes are listed at the end of this section.

Table 2-2
Fatal Error Messages

Message Description Beep Code*

CMOS RAM test failed A walking bit test of CMOS RAM location 0E
(Hex) - 3F (Hex) failed.

3

DMA controller faulty A sequential read/write of the transfer count
and transfer address registers within the
primary and secondary DMA controllers failed.

4

Faulty DMA page registers A walking bit read/write of the 16 DMA
controller page registers starting at location 80
Hex failed.

0

Faulty refresh circuits A continuous read/write test of port 61h found
that bit 4 (Refresh Detect) failed to toggle
within an allotted amount of time.

1

Interrupt controller failed A sequential read/write of various Interrupt
Controller registers failed.

5

ROM checksum incorrect A checksum of the ROM BIOS does not match
the byte value at F000:FFFF.

2

RAM error at location xxxx RAM error occurred during memory test. None

*Beep codes are defined in Table 2-3.
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Table 2-3
Fatal Error Beep Codes

Beep Code Beep Sequence Description Recommended Action

0 S-S-S-P-S-S-L-P The DMA page registers are faulty. Replace system board.

1 S-S-S-P-S-L-S-P The refresh circuitry is faulty.

2 S-S-S-P-S-L-L-P The ROM checksum is incorrect.

3 S-S-S-P-L-S-S-P The CMOS RAM test failed.

4 S-S-S-P-L-S-L-P The DMA controller is faulty.

5 S-S-S-P-L-L-S-P The interrupt controller failed.

6 S-S-S-P-L-L-L-P The keyboard controller failed.

7 S-S-L-P-S-S-S-P Graphics adapter is faulty.

8 S-S-L-P-S-S-L-P Internal RAM is faulty. Replace memory board or
system board if memory on
system board is faulty.

NOTE:  S = Short, L = Long, P = Pause
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2.5  Compaq Utilities

Compaq Utilities contain several functions that

■ Determine if various computer devices are recognized by the system and are
operating properly.

■ Provide information about the system once it is configured.

Compaq Utilities include the following programs:

■ Computer Setup

■ Computer Checkup (TEST)

■ View System Information (INSPECT)

To access Compaq Utilities:

1. Turn on or restart the computer by clicking Start ➔ Shut Down ➔ Restart the
computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the display.

3. Select a menu option.

Computer Setup

Computer Setup contains utilities that give you an overall picture of the computer
hardware configuration and aid in troubleshooting. These utilities also allow you to set
custom features such as security options, power conservation levels, and startup
preferences.

If you are running Windows 95, the computer automatically recognizes and configures
the system for new devices. If you have a configuration problem or want to view or
reset configuration settings, you can use Computer Setup.

NOTE:  If you are running Windows 95, you should use Computer Setup only to adjust
system features such as the power-on password or battery conservation level. Windows
95 may override other configuration changes.

If you are running Windows NT, the computer does not automatically recognize new
devices added to the system. All devices ordered with your system have been
configured for you. Use Computer Setup to view settings for a new device you have
added or to reset configuration settings for preinstalled devices.

Computer Setup provides two methods of viewing the computer configuration:  by type
(factory setting) or connection.
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Categories by type:

■ System Features—security, power, boot management

■ Communication—port, modem, and other communication devices

■ Storage—storage-related devices such as hard drive, CD-ROM drive, diskette drive

■ Input Devices—keyboard, mouse, and other input devices

■ Network—network adapter or other network-related devices

■ Audio—sound properties and audio device settings

■ Video—display timeouts and video device resources

■ Other—miscellaneous devices

Categories by connection:

■ System Features—security, power, boot management

■ System Devices—keyboard, mouse, parallel and serial ports

■ ISA—ISA bus and connected devices

■ PCI—PCI bus and connected devices

■ PC Card—PC Card devices

Running Computer Setup
1. Turn on or restart the computer by clicking Start ➔ Shut Down ➔ Restart the

computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the screen.

 NOTE:  If you a setup password is enabled, it must be used to access Computer Setup.

3. Click a language and press Enter.

4. Click Computer Setup and press Enter.

5. When you are finished, click Exit.
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Exiting Computer Setup
1. Click Exit.

2. Select one of the following Exit options:

■ Save—Saves the new settings and exits Computer Setup.

NOTE:  Some settings may not take effect until the computer is restarted.

■ Ignore—Exits Computer Setup and restores previous settings.

■ Cancel—Returns to Computer Setup.

Computer Checkup (TEST)

Computer Checkup (TEST) determines whether the various computer components and
devices are recognized by the computer and are functioning properly. You can display,
print, or save the information that Computer Checkup generates.

NOTE:  Compaq Utilities are intended for testing only Compaq-supplied components.
Testing of non-Compaq components may be inconclusive.

Running Computer Checkup (TEST)
1. Plug the computer into an external power source. A low battery condition can

interrupt the program.

2. Connect a printer if you want to print a log of error messages.

3. Turn on the external devices that you want to test.

4. Turn on or restart the computer.

5. Access Compaq Utilities by pressing F10 when the blinking cursor appears in the
upper-right corner of the display.

6. Click Computer Checkup ➔ View the Device List.

■ If the list of installed devices is correct, click OK.

■ If the list is incorrect, ensure that any new devices are installed properly.
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7. Select one of the following from the Test Option menu:

■ Quick Check Diagnostics

■ Automatic Diagnostics

■ Prompted Diagnostics

8. Follow the instructions on the screen as the devices are tested.

9. Click Exit Diagnostics ➔ Exit from this utility.

Computer Checkup (TEST) Error Codes

Computer Checkup (TEST) error codes occur if the system recognizes a problem while
running Computer Checkup. These error codes help identify possibly defective
assemblies. Tables 2-4 through 2-14 list Computer Checkup error codes, a description
of the error condition, and the recommended action for resolving the condition. For
removal and replacement procedures, refer to Chapter 5.

IMPORTANT:  Run Computer Checkup each time you complete a recommended action
step. If the problem is resolved when POST and Computer Checkup are rerun (i.e., with
no error codes), do not perform the remaining recommended action steps.

NOTE:  The error codes in the following tables are listed in an “AYY-XX” format,
where:

A or AA = Number that represents the faulty assembly

 YY = Test or action that failed

 XX = Specific problem

Table 2-4
Processor Test Error Codes

Error Code Description Recommended Action

101-xx CPU test failed. Replace the processor board and retest.

103-xx DMA page registers test failed. Replace the system board and retest.

104-xx Interrupt controller master test failed.

105-xx Port 61 error.

106-xx Keyboard controller self-test failed.

107-xx CMOS RAM test failed.

108-xx CMOS interrupt test failed.

109-xx CMOS clock test failed.

110-xx Programmable timer load data test failed.

113-xx Protected mode test failed.
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Table 2-5
Memory Test Error Codes

Error Code Description Recommended Action

200-xx Memory machine ID test failed. The following steps apply to error codes 200-xx
and 202-xx:

202-xx Memory system CMOS checksum failed. 1. Flash the system CMOS and retest.
2. Replace the system board and retest.

203-xx Write/Read test failed. The following applies to error codes 203-xx
through 215-xx:

204-xx Address test failed. Remove and replace the memory board or system
board (if the memory board on the system board
is faulty) and retest.

211-xx Random pattern test failed.

214-xx Noise test failed.

215-xx Random address test failed.

Table 2-6
Keyboard Test Error Codes

Error Code Description Recommended Action

300-xx Failed ID Test. The following steps apply to error codes 300-xx
through 304-xx:

1. Reseat the keyboard assembly.

301-xx Failed Self test/Interface Test. 2. Replace the keyboard and retest.

302-xx Failed Individual Key Test. 3. Replace the system board and retest.

304-xx Failed Keyboard Repeat Test.

Table 2-7
Parallel Printer Test Error Codes

Error Code Description Recommended Action

401-xx Printer failed or not connected. The following steps apply to error codes 401-xx
through 403-xx:

1. Connect the printer.

402-xx Failed Port Test. 2. Check power to the printer.

403-xx Printer pattern test failed. 3. Install the loopback connector and retest.

4. Check port and IRQ configuration.

5. Replace the system board and retest.
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Table 2-8
Diskette Drive Error Codes

Error Code Description Recommended Action

600-xx Diskette ID drive types test
failed.

The following steps apply to error codes 600-xx
through 698-xx:

601-xx Diskette format failed. 1. Replace the diskette.

602-xx Diskette read test failed. 2. Replace the diskette drive and retest.

603-xx Diskette write, read, compare test failed. 3. Replace the system board and retest.

604-xx Diskette random read test failed.

605-xx Diskette ID media test failed.

606-xx Diskette speed test failed.

609-xx Diskette reset controller test failed.

610-xx Diskette change line test failed.

697-xx Diskette type error.

698-xx Diskette drive speed not within limits.

699-xx Diskette drive/media ID error. 1. Replace media.

2. Run Compaq Utilities.

Table 2-9
Serial Test Error Codes

Error Code Description Recommended Action

1101-xx Serial port test failed. 1. Check port configuration.

2. Replace the system board and retest.
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Table 2-10
Hard Drive Test Error Codes

Error Code Description Recommended Action

1701-xx Hard drive format test failed. The following steps apply to error codes 1701-xx
through 1736-xx:

1. Run Compaq Utilities and verify drive type.

1702-xx Hard drive read test failed. 2. Verify that all secondary drives have secondary
drive capability.

1703-xx Hard drive write/read/compare test failed. 3. Replace the hard drive and retest.

1704-xx Hard drive random seek test failed. 4. Replace the system board and retest.

1705-xx Hard drive controller test failed.

1706-xx Hard drive ready test failed.

1707-xx Hard drive recalibration test failed.

1708-xx Hard drive format bad track test failed.

1709-xx Hard drive reset controller test failed.

1710-xx Hard drive park head test failed.

1715-xx Hard drive head select test failed.

1716-xx Hard drive conditional format test failed.

1717-xx Hard drive ECC* test failed.

1719-xx Hard drive power mode test failed.

1724-xx Network preparation test failed.

1736-xx Drive monitoring test failed.

*ECC = Error Correction Code
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Table 2-11
Video Test Error Codes

Error Code Description Recommended Action

501-xx Video controller test failed. The following actions apply to error codes 501-xx
through 516-xx:

502-xx Video memory test failed. 1. Disconnect external monitor and test with
internal LCD display.

503-xx Video attribute test failed. 2. Replace the display assembly and retest.
504-xx Video character set test failed. 3. Replace the system board and retest.
505-xx Video 80 × 25 mode 9 × 14 character

cell test failed.
506-xx Video 80 × 25 mode 8 × 8 character

cell test failed.
507-xx Video 40 × 25 mode test failed.
511-xx Video screen memory page test failed.
512-xx Video gray scale test failed.
514-xx Video white screen test failed.
516-xx Video noise pattern test failed.

2402-xx Video memory test failed. The following actions apply to error codes
2402-xx through 2456-xx:

2403-xx Video attribute test failed. 1. Run Compaq Utilities.
2404-xx Video character set test failed. 2. Disconnect external monitor and test with

internal LCD display.
2405-xx Video 80 × 25 mode 9 × 14 character cell

test failed.
3. Replace the display assembly and retest.

4. Replace the system board and retest.

2406-xx Video 80 × 25 mode 8 × 8 character cell test
failed.

2411-xx Video screen memory page test failed.
2412-xx Video gray scale test failed.
2414-xx Video white screen test failed.
2416-xx Video noise pattern test failed.
2418-xx ECG/VGC memory test failed.

2419-xx ECG/VGC ROM checksum test failed.

2421-xx ECG/VGC 640 × 200 graphics mode test
failed.

2422-xx ECG/VGC 640 × 350 16 color set test failed.

2423-xx ECG/VGC 640 × 350 64 color set test failed.

2424-xx ECG/VGC monochrome text mode test failed.

2425-xx ECG/VGC monochrome graphics mode test
failed.

2431-xx 640 × 480 graphics test failed.

2448-xx Advanced VGA Controller test failed.
Continued
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Table 2-11  Continued

Error Code Description Recommended Action

2451-xx 132-column Advanced VGA test failed.

2456-xx Advanced VGA 256 Color test failed.

2458-xx Advanced VGA Bit BLT test failed. The following action applies to error codes
2458-xx to 2480-xx:

2468-xx Advanced VGA DAC test failed. Replace the system board and retest.

2477-xx Advanced VGA data path test failed.

2478-xx Advanced VGA BitBLT test failed.

2480-xx Advanced VGA Linedraw test failed.

NOTE:  Refer to Table 2-25 for information about other video errors.

Table 2-12
Audio Test Error Codes

Error Code Description Recommended Action

114-01 Speaker test failed. 1. Check system configuration.
2. Verify display audio cable connection.

3206-xx Audio System Internal Error Replace the audio board and retest.

Table 2-13
Pointing Device Interface Test Error Codes

Error Code Description Recommended Action

8601-xx Pointing device test failed. The following action applies to error codes 8601-
xx and 8602-xx.

Replace the keyboard/CPU cover assembly.

8602-xx Interface test failed.

Table 2-14
CD-ROM Test Error Codes

Error Code Description Recommended Action

3301-xx CD-ROM drive read test failed. The following action applies to error codes 3301-
xx and 3305-xx and 6600-xx through 6623-xx.

1. Replace the CD and retest.

2. Verify that drivers are loaded and properly
installed.

3305-xx CD-ROM drive seek test failed. 3. Replace the CD-ROM drive and retest.

4. Replace the system board and retest.

6600-xx ID test failed.

6605-xx Read test failed.

6608-xx Controller test failed.

6623-xx Random read test failed.
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Running View System Information
(INSPECT)

The View System Information (INSPECT) utility provides information about the
computer and installed or connected devices. You can display, print, or save the
information.

1. Connect a printer if you want to print the INSPECT information.

2. Turn on or restart the computer.

3. Access Compaq Utilities by pressing F10 when the cursor blinks in the upper-right
corner of the display.

4. If prompted, select a language.

5. Click View System Information (INSPECT).

6. Click the item you want to view from the following list:

■  System ■  Audio

■  ROM ■  Operating system

■  Keyboard ■  System files

■  System ports ■  Windows files

■  System storage ■  Miscellaneous

■  Graphics

■  Memory

■  Network (applicable only if
computer is docked in the
ArmadaStation or Armada
MiniStation)

7. Follow the instructions on the screen to cycle through the screens, to return to the list
and choose another item, or to print the information.

8. Select Exit Inspect.
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Running Compaq Diagnostics

Compaq Diagnostics provides computer component information when the operating
system is working.

If you are running Windows 95, access Compaq Diagnostics for Windows by
double-clicking My Computer ➔ Control Panel ➔ Compaq Diagnostics.

If you are running Windows NT, access Windows NT Diagnostics by clicking Start ➔
Programs ➔ Administrative Tools ➔ Windows NT Diagnostics.

Boot Sequencing
1. Run Computer Setup.

2. Click the System Features icon ➔ Boot Management box ➔ MultiBoot tab.

3. Designate the hard drive boot (startup) sequence you want.

4. Click OK to accept the changes.

Factory Default Settings

Table 2-15
Initialization

Enable POST Memory Test Checked (enabled)

Keyboard Num Lock Unchecked (Off)

1 Hard drive in the computer hard drive bay

2 Hard drive in the computer MultiBay

3 Hard drive in the ArmadaStation or Armada
MiniStation

4 Hard drive in the ArmadaStation half-height bay (if
converted to a MultiBay)

Boot display Auto

Language Language of country

Table 2-16
Ports

Serial port 3F8, IRQ4

Infrared port 3F8, IRQ4

Parallel port 3F8, IRQ7

Ethernet port 300, IRQ9
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Table 2-17
Power

Low Battery Warning Beep Checked (enabled)

External Energy Saving Monitor Connected Unchecked (not connected)

Power Management

Enabled While operating power on battery

Conservation Level Medium

Level Definition

High Suspend Time:  5 minutes

Hibernation Timeout:  Immediate

Drive Timeout:  2 minutes

Screen Timeout:  2 minutes

Medium Suspend Time:  10 minutes

Hibernation Timeout:  1 hour

Drive Timeout:  6 minutes

Screen Timeout:  4 minutes

Custom Suspend Time:  disabled

Hibernation Timeout:  low battery

Drive Timeout:  always on

Screen Timeout:  always on

Table 2-18
Security

Enable QuickLock/QuickBlank Unchecked (Disabled)

Enable Power-On Password Unchecked (Disabled)

Disable Serial/Infrared Ports Unchecked (Enabled)

Disable Parallel Port Unchecked (Enabled)

Disable PC Card Slots Unchecked (Enabled)

Setup Password Password blank

Power-On Password Password blank

Diskette Drives

Disable Diskette Drives Unchecked (Enabled)

Disable Diskette Boot Unchecked (Enabled)
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2.6  Troubleshooting Without
Diagnostics

This section provides information about how to identify and correct some common
hardware, memory, and software problems. It also explains several types of messages
that may be displayed on the screen.

Since symptoms can appear to be similar, carefully match the symptoms of the
computer malfunction against the problem description in the Troubleshooting tables to
avoid a misdiagnosis.

Before Replacing Parts

When troubleshooting a problem, check the following items for possible solutions
before replacing parts:

■ Verify that cables are connected properly to the suspected defective parts.

■ Verify that all required device drivers are installed.

■ Verify that all printer drivers have been installed for each application.

Checklist for Solving Problems

If you encounter a minor problem with the computer or software applications, go
through the following checklist for possible solutions:

■ Is the computer connected to an external power source, or does it have a fully
charged battery pack installed?

■ Are all cables connected properly and securely?

■ Did the diskette drive contain a nonbootable diskette when you turned on the
computer?

■ Have you installed all the needed device drivers? For example, if you are using a
mouse, you may need to install a mouse device driver.

■ Are printer drivers installed for each application?

Eliminating the typical problems described in this Troubleshooting section may save
you time and money. If the problem appears related to a software application, check the
documentation provided with the software. You may discover something you can
resolve easily by yourself.

If the condition persists, contact your Compaq authorized dealer or service provider.
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Solving Audio Problems

Table 2-19
Solving Audio Problems

Problem Probable Cause Recommended Action(s)

Computer does not beep after
the Power-On Self-Test
(POST).

Speaker volume has been
turned down.

Adjust the volume with the volume control
buttons located at the top-right corner of the
computer.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save open files and resolve the
low-battery condition.

Computer does not beep to
indicate a low-battery
condition.

Low-battery warning beeps
have been turned off.

Enable low-battery warning beeps in
Windows 95 Power Properties or in
Computer Setup ➔ Power Management.

System beeps have been
turned down too low.

Press Fn+F5, then press the right arrow key
to increase the volume of the system beeps.

Audio playback is too low or
too loud.

The computer volume control
and/or the software volume
control needs to be adjusted.

In Windows 95, adjust the computer volume
control buttons and adjust the volume control
in Multimedia Properties.

NOTE:  The volume control in Multimedia
Properties only affects the “Wave” audio
sources such as system sounds and *.wav
file playback. To change other sources such
as MIDI, video sound, and game effects, use
the Volume Control application in
Accessories/Multimedia.

In Windows NT, adjust the multimedia
volume control under the Accessories folder.

Internal speakers produce no
sound.

Volume has been muted. Press the right volume control button to
increase the volume.

External speakers or
headphones are connected to
the computer, or the computer
is docked in the
ArmadaStation.

Use the external speakers or headphones or
use the ArmadaStation speakers.

To use the internal speakers, disconnect the
external speakers or headphones or undock
the computer.

Speaker wires are not
connected.

Make sure the speaker wires are connected
properly.

Speakers are bad. Replace the speakers.
Continued
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Table 2-19  Continued

Problem Probable Cause Recommended Action(s)

Internal speaker does not
produce sound when an
external audio source is
connected to the stereo
line-in jack.

Volume may be turned off or
set too low.

■ Adjust the volume control located at
the top right corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ➔
Multimedia.

■ Adjust the volume using the speaker
icon on the taskbar.

Line input may not be
connected properly.

Check line input connection.

Headphones or speakers are
connected to the stereo
speaker/headphone jack,
which disables the internal
speakers.

Disconnect the headphones or speakers to
enable the internal speakers.

External microphone does
not work.

The wrong type of microphone
or microphone plug is being
used.

Check to see if a monophonic electret
condenser microphone with a 3.5-mm plug
is being used.

The microphone may not be
connected properly.

Ensure that the microphone plug is properly
connected to the mono microphone jack.

Sound source is not selected. Ensure that microphone is selected as the
recording source in Control Panel ➔
Multimedia and that the recording level is
adjusted.

No sound from game
program.

Audio settings are not set
correctly.

Check the game program audio settings.

Computer volume control is
turned down.

Adjust the volume with the volume control
buttons located at the top-right corner of
the computer.

Headphones are connected. Use or disconnect the headphones.
Continued
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Table 2-19  Continued

Problem Probable Cause Recommended Action(s)

No sound from headphones. Volume or mixing controls set
incorrectly.

■ Adjust the volume with the volume
control buttons located at the top-right
corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ➔
Multimedia.

Sound source not selected. Verify that the sound source is selected in
Control Panel ➔ Multimedia.

Volume or mixing controls set
incorrectly.

■ Adjust the volume with the volume
control buttons located at the top-right
corner of the computer.

■ Check the volume and mixer controls
in Control Panel ➔ Multimedia.
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Solving Battery Problems

The following table lists some common battery problems and recommended actions to
take when they occur. The "Solving Power Problems" section in this chapter also may
be applicable.

Table 2-20
Solving Battery and Battery Gauge Problems

Problem Probable Cause Recommended Action(s)

The computer turns on the
first time it is used, but the
battery does not charge.

The battery pack is in
ship mode.

Remove and reinsert the battery pack.

Computer does not turn on
when battery pack is inserted
and power cord is unplugged.

Battery is discharged. Ensure that the battery pack is
properly installed.

Connect the computer to an external power
source and charge the battery pack.

Replace the battery pack with a fully charged
battery pack.

Check battery status by pushing the button on
the battery pack.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save any open file(s). Then do
one of the following:

■ Connect the computer to an external
power source.

■ Turn the computer off and replace the
battery pack.

Computer battery light blinks
to indicate low battery
condition, but computer does
not beep.

Low battery beeps were
turned off.

Volume is turned off or turned
down too low.

Run Computer Setup and turn on the low
battery warning beeps.

Press Fn+F5 to adjust the volume of the
system warning beeps.

Battery light does not turn on
to indicate battery pack Is
charging.

Battery pack is already
charged.

Battery pack was exposed to
temperature extremes.

No action is necessary.

Allow time for the battery pack to return to
room temperature.

Battery pack is at the end of
its life.

Replace the battery pack.

Continued
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Table 2-20  Continued

Problem Probable Cause Recommended Action(s)

Battery pack is warm to the
touch after charging.

Warming occurs during
charging.

No action is required.

Computer turned off and
information in memory was
lost when the battery pack
was replaced.

Hibernation was disabled,
Suspend was not initiated, or
a charged battery pack was
not inserted immediately after
the discharged battery pack
was removed.

To prevent loss of information next time,
initiate Suspend or enable Hibernation,
remove the discharged battery pack, and
immediately insert a fully charged battery
pack.

Auxiliary battery charge is low
because the computer was
not connected to a power
source for an extended period
of time.

Connect the computer to an external power
source for approximately 24 hours to fully
charge the auxiliary battery.

You have to set the date and
time every time you turn on
the computer.

Auxiliary battery charge is
low.

Connect the computer to an external source
for approximately 24 hours to fully charge
the auxiliary battery.

Auxiliary battery is at the end
of its life.

Replace the auxiliary battery.

Battery pack charge does not
last as long as expected.

Battery pack is being exposed
to high temperatures or
extremely cold temperatures.

Keep the battery pack within the
recommended operating temperature range
50°F to 104°F (10°C to 40°C) or
recommended storage range -4°F to 86°F
(-20°C to 30°C ). Recharge the battery pack.

Battery pack has partially
self-discharged.

If the computer is disconnected from the
external power for more than two weeks,
remove the battery pack to reduce the self-
discharge rate.

Power management is
disabled.

Press Fn+F7 and set the power
conservation level.

An external device or PC Card
is draining the battery.

Turn off or disconnect external devices
when not using them.

Computer is beeping and
battery power light is blinking.

Battery pack charge is low. Do one of the following:

■ Charge the battery pack.

■ Replace the battery pack.

■ Connect the computer to an external
power source.

■ Initiate Hibernation.
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Solving CD-ROM Drive Problems

Table 2-20
Solving CD-ROM Drive Problems

Problem Probable Cause Recommended Action(s)

CD-ROM drive cannot read a
compact disc.

Compact disc is not properly
seated in the CD-ROM drive.

Open the CD loading tray, lay the compact
disc on it, then close the tray.

Compact disc in the CD loading
tray is loaded upside down.

Open the CD loading tray, turn over the
compact disc (label facing up), then close
the tray.

Compact disc has a scratch
on its surface.

Insert a different compact disc.

CD-ROM drive is not
recognized by the computer.

CD-ROM drive is not
connected properly.

If you are running Windows 95, turn off the
computer. Remove the CD-ROM drive from
the MultiBay, then reinsert it.

If you are running Windows NT, turn off the
computer or initiate Suspend. Remove the
CD-ROM drive from the MultiBay, then
reinsert it.
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Solving Diskette and Diskette Drive Problems

Table 2-21
Solving Diskette and Diskette Drive Problems

Problem Probable Cause Recommended Action(s)

Diskette drive cannot read a
diskette.

Diskette media has a bad
sector.

Copy remaining files to the hard drive or
another formatted diskette. Reformat the
diskette.

Using the wrong diskette type
for the diskette drive type.

Use the required diskette type.

Diskette is not formatted. Format the diskette.

If you are using Windows 95:

1. From the Windows 95 desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ➔ File ➔ Format.

3. Fill in the appropriate information, then
click Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette drive cannot write to
a diskette.

Diskette is not formatted. Format the diskette.

If you are using Windows 95:

1. From the Windows 95 desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ➔ File ➔ Format.

3. Fill in the required information, then click
Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette is write-protected. Use another diskette that is not
write-protected or disable the write-protect
feature.

Writing to the wrong drive. Check the drive letter in your path statement.

Not enough space is left on
the diskette.

Save the information to another diskette.

Disable diskette write ability is
turned on.

Run Computer Setup. Click on the Storage
icon. Make sure Disable diskette write ability
is not checked.
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Solving Hard Drive Problems

CAUTION:  To prevent loss of information, always maintain an up-to-date backup of the
hard drive.

Table 2-22
Solving Hard Drive Problems

Problem Probable Cause Recommended Action(s)

Cannot access hard drive. Hard drive is not seated. Shut down the computer, remove and
reinsert the hard drive, then turn on the
computer.

Hard drive was inserted while
computer was on, in Suspend,
or in Hibernation.

Shut down the computer, then turn it on
again to initialize the hard drive during
power on.

Hard drive may be damaged. Try inserting another hard drive.

Reading hard drive takes
more time than usual after
restarting the computer.

Hibernation was initiated and
system is now exiting from it.

Give the system time to restore the
previously saved data.

Hard drive error occurs. Hard drive has bad sectors or
has failed.

Do one of the following:

■ If you are running Windows 95, access
ScanDisk by clicking Start ➔ Programs
➔ Accessories ➔ System Tools ➔
ScanDisk, then check the Automatically
fix errors box. Click Start to begin
scanning.

If you are running Windows NT, go to
the system prompt and type chkdsk to
scan for errors.

■ Reformat the hard drive.

■ Contact your Compaq authorized dealer,
reseller, or service provider or Compaq
customer support for assistance.

Hard drive error occurs. Hard drive may be damaged. Try inserting another removable drive, if the
hard drive is in the MultiBay.

Errors occur after starting
from an additional hard
drive.

Additional hard drive does not
have the software and drivers
necessary to boot and operate
correctly.

Boot from the hard drive supplied with the
computer or another hard drive that has the
necessary software and drivers.

Hard drive does not work. Hard drive is not seated. Turn off and unplug the computer, remove
the hard drive, then reinsert it.
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Solving Hardware Installation Problems

Table 2-23
Solving Hardware Installation Problems

Problem Probable Cause Recommended Action(s)

New device is not recognized
as part of the computer
system.

The system did not
automatically configure the
new device.

In Windows 95, double-click the Add New
Hardware icon in Control Panel.

Refer to the documentation that came with
the new device for installation instructions.

Cable(s) of new external
device are loose, or
power cables are unplugged.

Ensure that all cables are properly and
securely connected and the power cord is
plugged into an electrical outlet.

Power switch of new
external device is not turned
on.

1. Turn off the computer.

2. Turn on the external device.

3. Turn on the computer to integrate the
device with the computer system.

New device is not configured
for Windows NT.

Use Computer Setup to view settings for
the new device or to reset the configuration
settings for preinstalled devices.

New device does not meet
plug and play requirements
because it is a legacy ISA
card.

1. Run Computer Setup.

2. Add legacy card.

3. Set the necessary legacy card resources.

4. Save the changes.

5. Restart the computer.
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Solving Infrared Connection Problems

NOTE:  The computer is shipped with the infrared port disabled. The port must be
enabled each time the computer is started or restarted. Follow these steps to enable the
infrared port.

1. Click Start ➔ Settings ➔ Control Panel.

2. Double click the Infrared icon.

3. Select the Options tab.

4. Check the box labeled Enable Infrared Communications to select the Com3 port.

5. Click OK. The infrared icon appears on the task bar.

NOTE:  Windows NT does not support infrared communication.

Table 2-24
Solving Infrared Connection Problems

Problem Cause Recommended Action(s)

Cannot link with another
computer.

Interrupt request (IRQ) conflict Check IRQ assignments for conflicts and
reassign as necessary.

Baud rate conflict Select the same baud rate for both
computers.

# bits conflict Select the same “#bits” setting for both
computers.

Stop bit conflict Select the same stop byte for both
computers.

Parity conflict Select the same parity setting for both
computers.

Data transmission problem Direct sunlight, fluorescent
light, or flashing incandescent
light is close to the infrared
connections.

Remove the interfering light sources.

Interference from other
infrared devices

Keep remote control units and other infrared
devices away from the infrared connections.

Physical obstruction Do not place objects between the two units
that will interfere with a line-of-sight data
transmission.

Movement Do not move either unit during data
transmission.

Orientation Adjust devices so that they point within 30
degrees of each other.

Distance Verify that devices are not more than 3 feet
(1 meter) apart.
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Solving Modem Problems

Table 2-25
Solving Modem Problems

Problem Probable Cause Recommended Action(s)

Modem loses connection. The connection from the
phone line to the modem is
loose.

Check to make sure the telephone cable is
properly connected.

Call Waiting has not been
disabled.

Disable Call Waiting.

1. Click Start ➔ Control Panel ➔
double-click Modems.

2. From the General tab of the Modems
Properties page, click Dialing Properties.

3. From the My Locations tab of the Dialing
Properties page, check the box labeled
This location has call waiting. Select
*70, 70#, or 1170 from the drop-down list
to disable call waiting for your dialing
area.

Noisy telephone line Phone line noise causing
garbled or missing
characters, or slow data
transfer speeds.

Check your telephone and modem cable
connections. If they are a little loose, they
can cause noise on the line.

Check with your local telephone company for
a phone line filter.

Phone line noise causing a
disconnection.

Hang-up Delay S Register
(S10) set too low.

Change S10 default to 150.

1. Click Start ➔ Programs ➔
Accessories ➔ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press Enter.

This command causes the modem to take
longer to disconnect even if there is noise on
the line.

Continued
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Table 2-25 Continued

Problem Probable Cause Recommended Action(s)

No dial tone Phone service is not
connected to the telephone
wall jack.

Verify service from the local phone
company:

1. Unplug the telephone cable from the
telephone wall jack.

2. Connect a telephone to the jack, pick up
the handset, and listen for a dial tone. If
there is a dial tone, reconnect the modem
to the telephone wall jack with the
telephone cable and make sure all
connections are secure.

3. If there is still no dial tone, contact your
local phone company or building
manager.

The modem is not responding
to commands from the
computer keyboard.

Verify the modem and computer are
connected:

1. Click Start ➔ Programs ➔
Accessories ➔ HyperTerminal.

2. Go to Terminal Mode, then type AT and
press the Enter key.

If the modem displays OK, the modem
and computer are working together. If the
modem displays ERROR, or does not
respond, restart the computer and repeat
step 1.

3. Type ATDT and listen for a dial tone.

4. Type ATH0 (zero) to hang up.

Speaker Control AT Command
(ATM) is set to 0.

Set the Speaker Control to 1:

1. Click Start ➔ Programs ➔
Accessories ➔ HyperTerminal.

2. Go to Command Mode, type ATM1 and
press Enter.

3. Type ATH1 and listen for a dial tone.

4. Type ATH0 (zero) to hang up.

The modem is plugged into a
digital PBX line rather than an
analog line.

Plug the modem into an analog line. If you are
in an office, the analog line is often the one
connected to a fax machine or modem. To get
an analog line in a hotel, request a room with
a “data” line.

Characters are garbled and
transfer rates are slow.

There is noise in the
telephone line.

■ Check your telephone and modem
cable connections. If they are loose,
they can cause noise on the line.

■ Check with your local telephone
company for a phone line filter.

Continued
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Table 2-25 Continued

Problem Probable Cause Recommended Action(s)

Phone line noise causes a
disconnection.

Hang-Up Delay S Register
(S10) set too low.

Change S10 default to 150.

1. Click Start ➔ Programs ➔
Accessories ➔ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press Enter.

This command causes the modem to take
longer to disconnect even if there is noise
on the line.

Cellular connection doesn’t
work (United States only).

Environmental factors are
interfering with the cellular
connection.

Refer to “How the Environment Affects
Cellular Performance” in the Reference Guide
for more information.

Ten-digit dialing does not work
correctly under Windows 95.

Ten-digit dialing doesn’t work
correctly under Windows 95,
making it difficult to dial
numbers in a different area
code that are not long distance
calls.

Since Windows 95 does not limit the number
of digits you can enter in the Phone Number
field, set the Area Code field to match your
local area code. Then type the ten-digit
telephone number in the Phone Number field.

Modem cable
disables/interferes with other
telephony devices (Germany,
Austria, and Switzerland only).

The modem cable does not
provide the additional 4-wire
connection required in
Germany, Austria, and
Switzerland to form the serial
pass-through necessary so that
other devices can work on the
same phone line.

To use another telephony device on the same
line in these countries, unplug the modem
cable from the wall jack first.

Modem does not dial correctly
under Windows 95
(Switzerland and Germany
only).

The “Wait for dial tone before
dialing”  check box is checked.
This causes Windows 95 to
issue an ATDT; command. A
typical dial string would look
like this:

ATDT;

ATDTnnn-nnnn

In Germany and Switzerland,
the ‘ ;’  dial modifier is not
permitted to be used in this
fashion by regulatory agencies
since ATDT; takes the modem
off-hook without dialing.
Therefore, the modem returns
an error message when
attempting to dial. The error
message reads:

“The computer is not receiving
a response from the modem.
Check that the modem is
plugged in, and if necessary,
turn the modem off, then turn it
back on.”

1. Click Start ➔ Settings ➔ Control Panel.

2. Double-click the Modems icon.

3. Click the Properties button.

4. Select the Connection tab.

5. Click the “Wait for dial tone before dialing”
check box to clear it.

6. Click OK ➔ Close.
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Solving PC Card Problems

Table 2-26
Solving PC Card Problems

Problem Probable Cause Recommended Action(s)

Computer does not beep
when PC Card is inserted but
PC Card works correctly.

System beeps are turned
down.

PC Card sound effects have
been disabled.

Press Fn+F5, then press the right arrow key
to increase the system beeps volume.

In Windows 95, double-click PC Card icon ➔
Global Settings tab. Deselect Disable PC Card
Sound Effects.

Computer does not beep when
PC Card is inserted and PC
Card does not work.

PC Card is not inserted
properly.

The PC Card slots have been
disabled.

Remove and reinsert the card gently to avoid
damaging the pins.

Run Computer Setup to enable the PC Card
slots. When the system starts, press F10 then
select Computer Setup ➔ Other Devices ➔
PC  Card Controller ➔ Resources. Deselect
the “Disabled” check box.

In Windows 95, click Start ➔ Settings ➔
Control Panel ➔ System ➔ Device Manager
➔ PCMCIA Socket. Double-click the Texas
Instruments TI-1131 CardBus controller to
view device properties. Deselect the
“Disable in this hardware profile” check box.

Card or card driver is not
compatible with the computer
or with the operating system.

Contact service provider for a list of
compatible PC Cards.

Computer beeps twice, but
modem and/or fax does not
work.

Telephone cord is not plugged
in all the way.

Verify that the telephone connection is
secure.

The wrong COM port is being
used to access the card.

Verify the COM port assigned to the card and
within the application is correct.

In Windows 95, click Start ➔ Help ➔
Contents ➔ Troubleshooting ➔ Problem.
Follow the instructions on the screen.

Computer beeps twice but
network card does not work.

Network server is
unavailable.

Contact system administrator.

Computer beeps twice when
a storage card is inserted, but
the card does not work.

The wrong drive letter is
being used to access the
storage card.

Open Windows Explorer and verify the drive
letter.

PC Card does not work Windows NT was running
when the PC Card was
inserted.

Turn off the computer, reinsert the PC Card,
and restart the computer.
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Solving Power Problems

Table 2-27
Solving Power Problems

Problem Probable Cause Recommended Action(s)

Computer will not turn on. Computer is not connected to
a power source.

Insert battery pack or connect an external
power source.

Power cord to the external
power source is unplugged.

Ensure that power cord connecting the
computer and the external power source is
plugged in properly.

Battery pack is discharged. Insert a fully charged battery pack or
connect an external power source.

Computer will not turn on
when connected to external
power if battery pack is in the
computer.

Battery pack may be
defective.

Remove battery pack, insert another battery
pack, and try again.

Computer turned off while it
was left unattended and the
power/suspend light is off.

System initiated Hibernation
after a preset timeout.

Turn on the computer to restore information
at the point where Hibernation was initiated.

NOTE:  To change the Hibernation timeout
setting in Windows 95, click the Hibernation
tab in Power Properties. In Windows NT, run
Computer Setup and select Power
Management.

Computer turned off while it
was left unattended and will
not turn on.

System initiated Hibernation
and/or shut down because of
a critical low-battery
condition.

Replace the battery pack with a fully
charged battery pack or connect an external
power source, then turn on the computer.

Computer initiated Suspend
or turned off when it was
docked.

The maximum operating
temperature was exceeded.

Computer is in a high temperature
environment and the fan is not able to cool
it. Let the computer cool down and turn it on
again.

Make sure the ventilation intake and
exhaust are not obstructed.

Hibernation does not work
properly.

Hibernation was not reset
after a memory upgrade.

Reset Hibernation in the Power
Management utility.

Computer does not turn on
when connected to external
power and no batteries are
installed.

Internal power supply is bad. Replace the internal power supply.
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Solving Screen Problems

IMPORTANT:  Conduct all tests on a working monitor. If the recommended actions do
not solve the problem, replace the display. If the problem persists with a new display,
replace the system board.

Table 2-28
Solving Screen Problems

Problem Probable Cause Recommended Action(s)

Characters are dim. The brightness or contrast
control (if applicable) is not
set properly.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Computer screen is in direct
light.

Tilt the display or move computer.

Display is damaged. Replace the display.

Screen is blank. QuickLock/QuickBlank was
initiated.

Enter the password to exit
QuickLock/QuickBlank.

Screen save was
initiated after the Power
Management timeout period.

Press any key or click the mouse.

Brightness or contrast needs
adjusting.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Screen has overheated. If computer is in direct sunlight, move it and
allow it to cool.

Computer screen is blank and
the screen on an external
monitor displays information.

Display was switched to the
external monitor.

Press the Fn+F4 hotkeys to display
information on the computer screen.

Screen is blank and the
power/suspend light is
blinking.

System initiated Suspend. Press the suspend button to exit Suspend.
Enter the power-on password if prompted.

Screen is blank and the
power/suspend light and the
battery light are blinking.

System has entered a critical
low-battery condition.

Immediately connect the computer to an
external power source or replace the battery
pack.

Continued
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Table 2-28  Continued

Problem Probable Cause Recommended Action(s)

External monitor does not
display information.

External monitor was
connected after the computer
was turned on.

Press the Fn+F4 hotkeys to switch to the
external monitor.

The external monitor signal
cable or power cord is not
properly connected.

Ensure that the cables are properly
connected.

Small red, green, or blue
spots appear on the computer
CTFT display.

Small spots, called on-pixels,
often appear on CTFT
screens. Compaq limits the
number of these on-pixels to
0.003 percent.

No action is required.

Display on an external
monitor is distorted.

Incorrect display device
drivers are installed or
incorrect resolution is set.

Double-click the Display icon in Control
Panel, click the Settings tab, and set the
correct display type and resolution for the
external monitor.

The external monitor is not
Energy Star compliant, but
monitor energy saving feature
is enabled.

Complete these steps:

1. Press any key or move the pointing
device to restore the display.

2. If display remains distorted, turn off the
monitor, then turn it on again.

3. Disable the monitor energy saving feature
in Display Properties or in Computer
Setup Power Management.

The image has a black border
and does not fill the screen.

The Desktop Area setting is
smaller than the Resolution
setting.

Adjust the settings for the Desktop Area and
Resolution. Double-click Control Panel
Display ➔ Settings ➔ Compaq.

Press the Fn+T keys to expand the image.
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Solving USB Problems

Table 2-29
Solving USB Problems

Problem Probable Cause Recommended Action(s)

External device connected to
a USB connector does
not work.

The operating system limits
external devices connected by
USB to two tiers that can
include no more than two
hubs on the first tier and no
more than one keyboard and
one pointing device on the
first or second tier.

Reduce the number of connected external
USB devices to no more than two hubs on the
first tier, and no more than one keyboard and
one pointing device on the first or second tier.

External device connected to a
USB connector does not work
during startup (before
Windows 95 loads).

During startup, only two tiers
are supported by the USB
connector. These tiers can
include no more than two hubs
on the first tier and no more
than one keyboard and one
pointing device on the first or
second tier.

■ Use the external device only after
Windows 95 has loaded.

■ Reduce the number of connected
external USB devices to no more than
two hubs on the first tier, and no more
than one keyboard and one pointing
device on the first or second tier.

External devices in lower tiers
do not work.

An unpowered hub is
connected to another
unpowered hub.

■ Use only powered hubs.

■ Make sure that all unpowered hubs are
immediately preceded by powered
hubs in the USB chain.
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Illustrated Parts Catalog 3-1

Illustrated Parts Catalog
IMPORTANT:  Various spare parts for the Armada 7700 Family of Personal Computers
may appear to be identical to corresponding spare parts on the Armada 7800 computer.
However, due to color and mechanical differences, Armada 7700 spare parts should
never be used when servicing an Armada 7800 computer.

CAUTION:  Only spare parts listed in this chapter should be used to service an Armada
7800 computer. Failure to follow this caution can cause damage to the computer.
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3-2 Illustrated Parts Catalog

3.1  Computer System Major Components

Figure 3-1.  Computer System Major Components

Table 3-1
Spare Parts:  Computer System Major Components

Item Description Spare Part Number
  1 Display assembly (includes logo kit, audio assembly bracket thermal pad,

and keyboard label kit)
315015-001

continued
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Table 3-1  Continued

Item Description Spare Part Number
  2 Auxiliary battery (includes keyboard label kit) 220807-001

Miscellaneous Plastics Kit, includes: 313916-001
  3a
  3b
  3c
  3d
  3e

Auxiliary battery retainer
Left & right rear covers
Top & bottom PC Card eject levers
Hard drive tray
Memory expansion slot cover

Not Illustrated:
RJ-11 cover
DAA cover plug
Keyboard label kit

  4 Keyboard assembly (includes keyboard label kit and DAA cover) 314963-XXX
Belgian
Danish
Dutch
French
French

Canadian
German

-181
-081
-331
-051

-121
-041

Italian
International
Japanese
Korean
Latin American

Spanish
Norwegian

-061
-002
-291
-AD1

-161
-091

Portuguese
Spanish
Swedish
Swiss
Taiwanese
U.K. English
U.S. English/

Canadian

-131
-071
-101
-111
-AB1
-031

-001
  5 EasyPoint III pointing device caps 314938-001

Audio/USB board, includes: 314949-001
  6a
  6b

Audio/USB board
Audio/USB board insulator

RJ-11 cover plug (not illustrated)
Keyboard label kit

  7 Intel 266-MHz Pentium II processor board with MMX technology
(includes audio assembly bracket thermal pad and keyboard label kit)

314947-001

Miscellaneous Hardware Kit, includes: 314959-001
  8a

  8b

Expansion connector
shield

Audio assembly
bracket

Not illustrated:
Processor module assembly ground clips (2)
Keyboard label kit
Audio assembly bracket thermal pad
Keyboard thermal pad
base feet
keyboard connector insulator

  9 Modem board (includes insulator and keyboard label kit)
U.S. model
International model

313906-001
313906-002

Japanese model 313906-291

Audio only board (includes RJ-11 cover plug and keyboard label kit) 314956-001
10 System board, includes (not illustrated): 314937-001

Expansion connector shield
Keyboard connector insulator

Audio assembly bracket thermal pad
Keyboard label kit

11 PC Card assembly (includes audio assembly bracket thermal pad and
keyboard label kit) / pn

315114-001

12 Power supply (includes keyboard label kit) 220699-001
13 Fan (includes isolator and keyboard label kit) 267862-002

CPU base assembly, includes: 314940-001
14a
14b
14c

I/O bracket insulator
I/O bracket
Base assembly, includes: Base assembly I/O bracket

Base feet
Keyboard label kit
Keyboard connector shield
I/O bracket insulator

Hard drive release assembly
Battery release assembly
MultiBay release assembly
Expansion connector shield

Top and bottom PC Card doors
Left and right tilt feet
Security clip
Infrared lens

15 Battery pack, Li-ion 314939-001
16 5.0 GB hard drive (includes Armada 7700 and 7800 hard drive trays) 315140-001
17 32-MB memory expansion board 313911-001

3-volt Lithium disc cell battery (not illustrated) 117099-001
Miscellaneous screws kit (not illustrated; refer to Appendix C) 31958-001
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3.2  Miscellaneous Plastics Kit Components

Figure 3-2.  Miscellaneous Plastics Kit Components

Table 3-2
Miscellaneous Plastics Kit Components

Spare Part Number 313916-001
Item Description
  1 Hard drive tray
  2 Auxiliary battery retainer
  3 Memory expansion slot cover
  4 Left & right rear covers
  5 Top & bottom PC Card eject levers

Not Illustrated:
RJ-11 cover
DAA cover plug
Keyboard label kit
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3.3  Miscellaneous Hardware Kit Components

Figure 3-3.  Miscellaneous Hardware Kit Components

Table 3-3
Miscellaneous Hardware Kit Components

Spare Part Number 314959-001
Item Description
  1 Audio assembly bracket
  2 Expansion connector shield
  3 Processor module assembly ground clips (2)

Keyboard label kit (not illustrated)
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3.4  Power Equipment

Figure 3-4.  Power Equipment

Table 3-4
Spare Parts:  Power Equipment

Item Description Spare Part Number

  1 Battery pack, Li-ion 314939-001

  2 Auxiliary battery 220807-001

  3 Battery charger 277734-001

  4 Automobile/aircraft adapter
Automobile/aircraft adapter cable

313919-001
315083-001

  5 Power cord
Australian
Danish
European
Italian
Japanese

314957-011
314957-081
314957-002
314957-061
314957-291

Korean
French/German/

Swiss
U.K. English/Asia

Pacific/Hong Kong
U.S. English

314957-AD1
314957-111

314957-031

314957-001
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3.5  Mass Storage Devices

Figure 3-5.  Mass Storage Devices

Table 3-5
Spare Parts:  Mass Storage Devices

Item Description Spare Part Number
  1 5.0-GB hard drive (standard equipment, also available

as option)
305897-001

  2 20X Max CD-ROM drive (standard equipment, also available
as option)

314936-001

  3 Diskette drive, 1.44-megabyte, 3.5-inch (standard equipment) 314941-001
  4 External diskette drive (available only as an option)

External diskette drive cable (not illustrated)
290837-001
258575-002

  5 SuperDisc LS-120 drive (available only as an option) 327456-002
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3.6  Items that Ship with the Computer

Figure 3-6.  Items that Ship with the Computer
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Table 3-6
Items that Ship with the Computer

Item Description Spare Part Number

  1 5.0-GB hard drive 315140-001

  2 MultiBay weight saver (ships in accessory box) 315113-001

  3 Diskette drive, 1.44-megabyte, 3.5-inch (ships in
accessory box)

314941-001

  4 20X Max CD-ROM drive 314936-001

  5 Battery pack, Li-ion 314939-001

  6 Power cord
Australian
Danish
European
Italian
Japanese
Korean
French/German/Swiss
U.K. English/Asia Pacific/Hong Kong
U.S. English

314957-011
314957-081
314957-002
314957-061
314957-291
314957-AD1
314957-111
314957-031
314957-001

  7 Auxiliary battery 220807-001

  8 Telephone cable (country specific) 138609-001

  9 Modem cable (country specific) 248080-001

10 Slipcase (Europe/Middle East/Africa only) 315108-001

11a
11b
11c
11d

Security kit
Single bay security screw
Dual bay security screw
Security wrench
Memory expansion slot cover security screw

296035-001

12 EasyPoint III pointing device caps (2) 314938-001
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3.7  Options

Figure 3-7.  Options
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Table 3-7
Spare Parts:  Options

Item Description Spare Part Number Option Part Number
  1 Automobile/aircraft adapter 313919-001 296537-B21
  2 Memory expansion board

16-MB
32-MB
64-MB

313917-001
313911-001
313918-001

314889-B21
314890-B21
314891-B21

  3 20X Max CD-ROM drive (includes slipcase) 314936-001 297707-B25
  4 Armada 7000 Hard Drive MultiBay Adapter 296586-001 267868-001
  5 Cellular phone cable

GE & Ericson CT7000
Motorola-MT/Elite
Motorola-MicTac
Nokia-232
Nokia-2120

212035-001
212031-001
212030-001
212034-001
212033-001

185272-001
185268-001
185267-001
185271-001
185270-001

  6 5.0-GB hard drive (includes hard drive
carrying case)

305897-001 297189-B25

  7 Headset 273139-001 220460-001
  8 Battery charger 277734-001 220461-001
  9 Battery pack, Li-ion 314939-001 220463-B25

10a
10b
10c
10d
10e
10f

SpeedPaq Cellular PC Card Kit, includes:
SpeedPaq Cellular PC Card
computer interconnect block
modem interconnect block
interconnect cable
remote antenna base
antenna
cellular PC Card software (not illustrated)

221227-001 221202-001

11 External Diskette Drive Kit 290837-001 297186-B21
12 SuperDisc LS-120 drive 327456-002 296502-B25
13 Portable Video Conferencing Kit 298450-001 296954-001



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

3-12 Illustrated Parts Catalog

3.8  Miscellaneous

Table 3-8
Spare Parts:  Miscellaneous (not illustrated)

Description Spare Part Number
Country Kit

Domestic
International
Japanese

315084-001
315084-002
315084-291

Miscellaneous Screws Kit (includes keyboard label kit) 314958-001
Return Kit 272186-001
Carton & shipping buns kit, international 272186-002
Tool Kit, includes:

case utility tool
connector removal tool
loop back plugs

100767-001

3.9  Documentation

Table 3-9
Spare Parts:  Documentation (not illustrated)

Description Spare Part Number
Armada 7800 Maintenance & Service Guide 314960-001
Armada 7800 Illustrated Parts Map* 314961-001
ArmadaStation and Armada MiniStation Maintenance & Service Guide 296390-001
ArmadaStation and Armada MiniStation Illustrated Parts Map* 296391-001
Armada 7800 Setup Poster & Reference Guide:  available in country kits or through fulfillment

*Not available in Europe, Middle East, or Africa
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Removal and Replacement
Preliminaries

This chapter provides essential information for proper and safe removal and
replacement service.

4.1  Tools Required

You will need the following tools to complete the removal and replacement procedures:

■ Magnetic screwdriver

■ Torx T-8 screwdriver (for all screws unless otherwise specified)

■ Torx T-10 screwdriver (for memory expansion slot cover screw)

■ 3/16-inch nut driver (for all screwlocks and standoffs)

■ 7-mm hex socket (for bushing guides)

■ Security wrench included in the security kit (for tamper-resistant memory
compartment cover screws and/or tamper-resistant hard drive security plate have
been installed)

■ Tool kit (includes connector removal tool, loopback plugs, and case utility tool)

■ X-acto knife or scraper (to remove thermal pad residue from audio assembly bracket
and processor module assembly.) Refer to Section 5.15.

4.2  Service Considerations

Listed below are some of the considerations that you should keep in mind during
disassembly and assembly procedures.

Plastic Parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

IMPORTANT:  As you remove each subassembly from the computer, place it (and all
accompanying screws) away from the work area to prevent damage.
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Cables and Connectors

Cables must be handled with extreme care to avoid damage. Apply only the tension
required to unseat or seat the cables during removal and insertion. Handle cables by the
connector whenever possible. In all cases, avoid bending, twisting, or tearing cables.
Ensure that cables are routed in such a way that they cannot be caught or snagged by
parts being removed or replaced. Handle flex cables with extreme care; they tear easily.

CAUTION:  When servicing the computer, ensure that cables are placed in their proper
location during the reassembly process. Improper cable placement can damage the
computer.

4.3  Preventing Damage to Removable Drives

Removable drives are fragile components that must be handled with care. A hard drive
carrying case and a MultiBay device carrying case are supplied with the computer to
protect drives when they out of the drive bays. To prevent damage to the computer,
damage to a removable drive, or loss of information, observe these precautions:

■ Before removing or inserting a hard drive, shut down the computer. If you are unsure
whether the computer is off or in Hibernation, turn the computer on, then shut it
down.

■ Before removing a diskette drive or CD-ROM drive, ensure that a diskette or disc is
not in the drive. Ensure that the CD-ROM tray is closed.

■ Before handling a drive, ensure that you are discharged of static electricity. While
handling a drive, avoid touching the connector.

■ Handle drives on surfaces that have at least one inch of shock-proof foam.

■ Avoid dropping drives from any height onto any surface.

■ After removing a hard drive, place it into the hard drive carrying case. Do not place a
hard drive into the MultiBay device carrying case.

■ After removing a CD-ROM drive or a diskette drive, place it into the MultiBay
device carrying case.

■ Do not use excessive force when inserting a drive into a drive bay.

■ After inserting a hard drive into the hard drive bay, always reinsert either the original
hard drive security plate or the tamper-resistant security plate to prevent the hard
drive from accidentally disconnecting.

■ Avoid exposing a hard drive to products that have magnetic fields such as monitors
or speakers.

■ Avoid exposing a drive to temperature extremes or to liquids.

■ If a drive must be mailed, do the following. Place the drive into its carrying case.
Place the carrying case into a bubble pack mailer or other suitable form of protective
packaging. Label the package “Fragile: Handle With Care.”
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4.4  Preventing Electrostatic Damage

Many electronic components are sensitive to electrostatic discharge (ESD). Circuitry
design and structure determine the degree of sensitivity. Networks built into many
integrated circuits provide some protection, but in many cases the discharge contains
enough power to alter device parameters or melt silicon junctions.

A sudden discharge of static electricity from a finger or other conductor can destroy
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but
damage occurs. An electronic device exposed to electrostatic discharge may not be
affected at all and can work perfectly throughout a normal cycle. Or it may function
normally for a while, then degrade in the internal layers, reducing its life expectancy.

Packaging and Transporting Precautions

Use the following grounding precautions when packaging and transporting equipment:

■ To avoid hand contact, transport products in static-safe containers such as tubes,
bags, or boxes.

■ Protect all electrostatic-sensitive parts and assemblies with conductive or approved
containers or packaging.

■ Keep electrostatic-sensitive parts in their containers until they arrive at static-free
workstations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging
or non-conductive foam.

■ Use transporters and conveyers made of antistatic belts and roller bushings. Ensure
that mechanized equipment used for moving materials is wired to ground, and that
proper materials were selected to avoid static charging. When grounding is not
possible, use an ionizer to dissipate electric charges.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

4-4 Removal and Replacement Preliminaries

Workstation Precautions

Use the following grounding precautions at workstations:

■ Cover the workstation with approved static-dissipative material (refer to Table 4-2
later in this chapter).

■ Use a wrist strap connected to a properly grounded work surface and use properly
grounded tools and equipment.

■ Use field service tools, such as cutters, screwdrivers, and vacuums that are
conductive.

■ When using fixtures that must directly contact dissipative surfaces, use fixtures made
of static-safe materials only.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly
aids and Styrofoam.

■ Handle electrostatic-sensitive components, parts, and assemblies by the case or PCM
laminate. Handle them only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.

■ Turn off power and input signals before inserting or removing connectors or test
equipment.
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Grounding Equipment and Methods

Grounding equipment must include either a wrist strap or a foot strap at a grounded
workstation.

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are
flexible straps with a minimum of one megohm ±10% resistance in the ground cords.
To provide proper ground, a strap must be worn snug against the skin. On grounded
mats with banana-plug connectors, connect a wrist strap with alligator clips.

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or
boot straps) can be used at standing workstations and are compatible with most types
of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a minimum of one-megohm resistance between the operator and ground. To
be effective, the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing electrostatic damage
include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Non-conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

■ Material-handling packages

■ Non-conductive plastic bags, tubes, or boxes

■ Metal tote boxes
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Electrostatic Voltage Levels and Protective Materials

Table 4-1 shows how humidity affects the electrostatic voltage levels generated by
different activities.

Table 4-1
Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker  6,000 V    800 V   400 V

Removing DIPS from plastic tube  2,000 V    700 V   400 V

Removing DIPS from vinyl tray 11,500 V  4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V  5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

NOTE: 700 volts can degrade a product.

Table 4-2 lists the shielding protection provided by antistatic bags and floor mats.

Table 4-2
Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags  1,500 V

Carbon-loaded plastic Floor mats  7,500 V

Metallized laminate Floor mats 15,000 V
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Removal and Replacement
Procedures

5.1  Serial Number

The computer serial number should be reported to Compaq when requesting
information or ordering spare parts. The serial number is located on the bottom of the
computer (Figure 5-1).

Figure 5-1.  Serial Number Location
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5.2  Disassembly Reference Chart

Use the chart below to determine the section number to be referenced when removing
components from the computer.

5.4  Preparing the Computer for Disassembly
Undocking the Computer

Undocking the Computer from the ArmadaStation
Undocking the Computer from the Armada MiniStation

Disconnecting the Computer
5.5  Computer Logo
5.6  Computer Feet
5.7  Battery Packs

Removing a Battery Pack from the Battery Bay
Removing a Battery Pack from the MultiBay
Inserting a Battery Pack into the Battery Bay
Inserting a Battery Pack into the MultiBay

5.8  Hard Drives
Removing a Hard Drive from the Hard Drive Bay
Inserting a Hard Drive into the Hard Drive Bay
Inserting a Hard Drive into the MultiBay
Removing a Hard Drive from the MultiBay

5.9  MultiBay Devices
Removing Drives from the MultiBay
Inserting Drives into the MultiBay

5.10  Memory Expansion
Removing the Memory Expansion Slot Cover
Removing a Memory Expansion Board
Installing a Memory Expansion Board
Removing the Memory Expansion Slot Cover

5.11  Keyboard Assembly
5.12  Power Supply
5.13  Fan Assembly
5.14  Audio/USB Board
5.15  Modem Board
5.16  Audio Assembly Bracket
5.17  Lithium Disc Cell Battery
5.18  Processor Module Assembly
5.19  Display Assembly and auxiliary battery

Removing the Display Assembly
Installing the Display Assembly

5.20  PC Card Eject Levers
Installing the PC Card Eject Levers

5.21  System Board
5.22  PC Card Assembly
5.23  I/O Bracket

Figure 5-2.  Computer Disassembly Sequence Chart
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5.3  Disassembly Sequence Chart

Use the chart below to determine the disassembly sequence for removing components
from the computer. To remove a component, remove all components that precede the
specified component in the chart.

For example, to remove the modem, you must first undock the computer, disconnect the
computer, remove the battery pack, remove the memory, remove the keyboard, and
remove the audio/USB board.

To remove the fan, you must first undock the computer, disconnect the computer,
remove the battery pack, remove the memory, and remove the keyboard. The
audio/USB board does not need to be removed, since it is on the same level on the chart
as the fan.

Undock the computer (Section 5.4)

Disconnect computer (Section 5.4)

Remove battery pack (Section 5.7)

Remove memory (Section 5.10)

Remove the keyboard (Section 5.11)

Remove audio/USB board (Section 5.14)

Remove modem (Section 5.15)

Remove audio assembly bracket (Section 5.16)

Remove Lithium disc cell battery (Section 5.17)

Remove processor module assembly (Section 5.18)

Remove display assembly and auxiliary battery (Section
5.19)

Remove expansion connector shield (Section 5.21)

Remove power supply (Section 5.12)

Remove fan (Section 5.13)

Remove PC Card eject levers (Section 5.20)

Remove hard drive (Section 5.8)

Remove MultiBay device (Section 5.9)

Remove system board (Section 5.21)

Remove PC Card assembly (Section 5.22)

Remove I/O Bracket (Section 5.23)

Figure 5-3.  Computer Removal Replacement Chart
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5.4  Preparing the Computer for Disassembly
1. Undock the computer from the ArmadaStation or Armada MiniStation.

2. Disconnect power and external devices.

3. Remove battery packs inserted into the battery bay or MultiBay (Section 5.7).

4. Remove PC Cards.

Undocking the Computer

If the computer is not docked in an ArmadaStation or Armada MiniStation, go to the
"Disconnecting the Computer" section. If the computer is docked, go to the "Undocking
the Computer from the ArmadaStation" or "Undocking the Computer from the Armada
MiniStation" section.

Undocking the Computer from the ArmadaStation
1. Unlock the ArmadaStation keylock.

2. Shut down the computer

3. Close the computer.
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4. Press the eject button 1 . The computer separates from the docking connector on the
ArmadaStation 2  (Figure 5-4).

Figure 5-4.  Undocking the Computer from the ArmadaStation

6. Slide the computer out of the ArmadaStation.
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Undocking the Computer from the Armada MiniStation
1. Shut down the computer.

2. Close the computer.

3. Lift the docking lever and slide it forward 1 . The computer separates from the
docking connector on the Armada MiniStation 2  (Figure 5-5).

Figure 5-5.  Undocking the Computer from the Armada MiniStation

4. Slide the computer away from the Armada MiniStation and remove it.
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Disconnecting the Computer

If the computer is docked in an ArmadaStation or Armada MiniStation, refer to the
"Undocking the Computer" section. If the computer is not docked in an ArmadaStation
or Armada MiniStation, refer to Figure 5-6 and follow these steps to disconnect the
computer:

1. Shut down the computer.

2. Close the computer.

3. Position the computer so the rear panel faces forward.

4. Disconnect the power cord from the wall outlet 1 .

5. Disconnect the power cord from the computer 2 .

Figure 5-6.  Disconnecting the Computer

7. Turn off and disconnect external devices.
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5.5  Computer Logo

The computer logo has an adhesive backing for installation. Remove the protective
covering from the adhesive back and install the logo (Figure 5-7). The logo is upside
down when viewed from the back of the computer with the display open.

Figure 5-7.  Installing the Computer Logo



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Removal and Replacement Procedures 5-9

5.6  Computer Feet

The computer feet are oblong, adhesive-backed rubber pads. The computer feet are
included in the Miscellaneous Hardware Spare Kit.

Install the feet by removing the protective covering from the adhesive back and
attaching the feet to the bottom of the computer (Figure 5-8).

Figure 5-8.  Installing the Computer Feet
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5.7  Battery Packs

! WARNING:  To reduce the risk of injury or damage to the battery pack, do not crush,
puncture, or incinerate the battery pack or short the metal contacts. Do not attempt to
open or service the battery pack.

Removing a Battery Pack from the
Battery Bay

Follow these steps to remove a battery pack from the battery bay:

1. If the computer is turned on, press the suspend button. If there is hard drive or
diskette drive activity, Suspend may not occur immediately. The computer screen
clears and the power/suspend light begins to flash when Suspend is initiated.

If the computer is turned off or in Suspend or Hibernation, proceed to Step 2.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Removal and Replacement Procedures 5-11

2. Tilt the computer at an angle 1  so the bottom of the computer is accessible
(Figure 5-9).

3. Slide the battery release latch to the right 2 .

4. Grasp battery pack using the recess 3  beneath the battery bay.

Figure 5-9.  Releasing a Battery Pack from the Battery Bay
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5. Pull the battery pack out of the battery bay (Figure 5-10).

Figure 5-10.  Removing a Battery Pack from the Battery Bay

Removing a Battery Pack from
the MultiBay

1. If the computer is turned on, press the suspend button. If there is hard drive or
diskette drive activity, Suspend may not occur immediately.

The computer screen clears and the power/suspend light begins to flash when
Suspend has been initiated.
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2. Tilt the computer at an angle 1  so the bottom of the computer is accessible
(Figure 5-11).

3. If the battery pack has been secured in the MultiBay with a single- or dual-bay
security screw 2 , remove the screw with the security wrench included with the
computer.

4. Slide the MultiBay release latch toward the rear of the computer 3 .

5. Grasp the battery pack using the recess 4  beneath the MultiBay.

Figure 5-11.  Releasing a Battery Pack from the MultiBay
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6. Pull the battery pack out of the MultiBay (Figure 5-12).

Figure 5-12.  Removing a Battery Pack from the MultiBay
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Inserting a Battery Pack into the
Battery Bay

! WARNING:  To prevent damage to the computer, do not insert a battery pack into the
battery bay until the computer is fully reassembled.

1. With the battery pack label facing up and the battery pack contacts facing the
computer, slide the battery pack into the battery bay until it clicks into place
(Figure 5-13).

Figure 5-13.  Inserting a Battery Pack into the Battery Bay

2. If the computer is in Suspend, press the suspend button to return to your work.
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Inserting a Battery Pack into the MultiBay

! WARNING:  To prevent damage to the computer, do not insert a battery pack into the
MultiBay until the computer is fully reassembled.

1. With the battery pack label facing up and the battery pack contacts facing the
computer, slide the battery pack into the MultiBay until it clicks into place.

2. If the battery pack was secured in the MultiBay using a single- or dual-bay security
screw, replace the screw (Figure 5-14).

Figure 5-14.  Inserting a Battery Pack into the MultiBay

3. If the computer is in Suspend, press the suspend button to return to your work.
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5.8  Hard Drives

Removing a Hard Drive from the Hard
Drive Bay

Before removing a hard drive, back up all information on the hard drive.

1. Save all work, exit all applications, and shut down the computer.

2. Tilt the computer at an angle 1  so the bottom of the computer is accessible
(Figure 5-15).

3. If the hard drive has been secured in the hard drive bay with a single- or dual-bay
security screw 2 , remove the screw with the security wrench included with the
computer.

4. Slide the hard drive release latch to the left 3 .

5. Grasp the hard drive using the recess beneath the hard drive bay 4 .

Figure 5-15.  Releasing a Hard Drive from the Hard Drive Bay
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6. Pull the hard drive out of the hard drive bay (Figure 5-16).

Figure 5-16.  Removing a Hard Drive from the Hard Drive Bay
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7. Pull the metal hard drive up and out of the plastic hard drive tray (Figure 5-17).

Figure 5-17.  Removing the Hard Drive from the Hard Drive Tray

8. If you are not inserting another hard drive, insert the hard drive tray into the hard
drive bay until it is seated.
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Inserting a Hard Drive into the Hard
Drive Bay

1. Save all work, exit all applications, and shut down the computer.

2. Release the hard drive tray from the hard drive bay by sliding the hard drive release
latch to the left.

3. Grasp the hard drive tray using the recess beneath the hard drive bay.

4. Pull the hard drive tray out of the hard drive bay.

5. Insert the metal hard drive into the plastic hard drive tray with the
connectors protruding through the opening in the rear of the tray (Figure 5-18).

Figure 5-18.  Inserting a Hard Drive into the Hard Drive Tray
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6. Slide the hard drive assembly into the hard drive bay (Figure 5-19).

Figure 5-19.  Inserting a Hard Drive into the Hard Drive Bay

7. If the hard drive was secured in the hard drive bay using a single- or dual-bay
security screw, replace the screw.
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Inserting a Hard Drive into the MultiBay

If you are moving a hard drive from the hard drive bay to the MultiBay, remove the
hard drive from the hard drive tray. Refer to the “Removing a Hard Drive from the Hard
Drive Bay” section in this chapter for more information.

An Armada 7000 Hard Drive MultiBay Adapter is needed to insert a hard drive into the
MultiBay. This adapter is included with the purchase of an optional hard drive.

1. Save all work, exit all applications, and shut down the computer.

2. Push back the slide tab 1  on the Armada 7000 Hard Drive MultiBay Adapter
(Figure 5-20).

3. Lower the hard drive 2  into the adapter.

4. Slide the hard drive toward the connector 3  in the adapter until the connectors
are seated.

Figure 5-20.  Inserting a Hard Drive into a Broadway Hard Drive MultiBay Adapter

5. Release the slide tab.

6. Slide the hard drive assembly into the MultiBay with the bezel facing out.
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NOTE:  You can secure the hard drive assembly in the MultiBay using a single- or
dual-bay security screw included with the computer.

Removing a Hard Drive from the MultiBay

Before removing a hard drive, back up all information on the hard drive.

1. Save all work, exit all applications, and shut down the computer.

2. Tilt the computer at an angle 1  so the bottom of the computer is accessible
(Figure 5-21).

3. If the hard drive assembly is secured in the MultiBay with a single- or dual-bay
security screw 2 , remove the screw with the security wrench included with the
computer.

4. Slide the MultiBay release latch 3  toward the rear of the computer.

5. Grasp the hard drive assembly using the recess 4  beneath the MultiBay.

Figure 5-21.  Releasing the Hard Drive Assembly from the MultiBay
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6. Pull the hard drive assembly out of the MultiBay (Figure 5-22).

Figure 5-22.  Removing the Hard Drive Assembly from the MultiBay

If you are not inserting another drive or a battery pack into the MultiBay, insert the
MultiBay weight saver included with the computer.

5.9  MultiBay Devices

Removing MultiBay Devices
1. Save all work, exit all applications, and shut down the computer.

2. Remove the media (diskettes, CD-ROMs, etc.) from the drive. Ensure that the
CD tray is closed.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Removal and Replacement Procedures 5-25

3. Tilt the computer at an angle 1  so the bottom of the computer is accessible
(Figure 5-23).

4. If the drive has been secured in the MultiBay with a single- or dual-bay security
screw 2 , remove the screw with the security wrench included with the computer.

5. Slide the MultiBay release latch 3  toward the back of the computer.

6. Grasp the drive using the recess 4  beneath the MultiBay.

Figure 5-23.  Releasing a Drive from the MultiBay
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7. Pull the drive out of the MultiBay (Figure 5-24).

Figure 5-24.  Removing a Drive from the MultiBay

If you are not inserting another drive or a battery pack into the MultiBay, insert the
MultiBay weight saver included with the computer.
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Inserting MultiBay Devices
1. Save all work, exit all applications, and turn off the computer.

2. Remove the media (diskettes, CD-ROM’s, etc.) from the drive to be inserted in the
MultiBay. Ensure that the CD tray is closed.

3. With the bezel facing out, slide the drive into the MultiBay until it clicks into place
(Figure 5-25).

Figure 5-25.  Inserting a Drive into the MultiBay
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5.10  Memory Expansion

Removing the Memory Expansion
Slot Cover

The memory expansion compartment is located on the bottom of the computer. Either
one or two memory expansion boards can be installed at a time.

CAUTION:  Electrostatic discharge (ESD) can damage electronic components. Before
beginning this procedure, ensure that you are properly grounded. For more information,
refer to Appendix C, “Electrostatic Discharge.”

1. Prepare the computer for disassembly (Section 5.4).

2. Remove any battery pack(s) from the computer (Section 5.7).

! WARNING:  Failure to unplug the power cord and remove the battery pack before
installing a memory expansion board can damage the equipment and expose you to the
risk of electrical shock.

3. Turn the computer upside down and position it so the rear panel faces forward.
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4. Remove the screw that secures the memory expansion slot cover to the computer 1

(Figure 5-26). A security wrench is needed to remove the screw securing the cover.

5. Slide the cover to the right 2  and lift it straight up to remove it.

Figure 5-26.  Removing the Memory Expansion Slot Cover
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Removing a Memory Expansion Board
1. Lift and hold back the memory insulator 1 . The insulator is not removable

(Figure 5-27).

2. Spread the retaining tabs apart.

3. Lift up the edge of the memory expansion board 2 .

4. Pull the memory expansion board out of the memory expansion slot at a 45-degree
angle 3 .

Figure 5-27.  Removing a Memory Expansion Board

5. Place the memory expansion board in an electrostatic-safe container.

6. If no memory expansion board is to be installed, reset the memory insulator.

7. Replace the memory expansion slot cover and install the screw.
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Inserting a Memory Expansion Board

The memory expansion boards are asymmetrically keyed (notched) to ensure correct
positioning.

1. Insert the memory expansion board into an empty memory expansion slot at a
45-degree angle 1  (Figure 5-28).

2. Push the board into place until it is seated.

3. Push the memory expansion board down until the board is seated in the plastic
retention clips 2 .

Figure 5-28.  inserting a Memory Expansion Board

4. Run Computer Setup (Section 2.5).
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Replacing the Memory Expansion
Slot Cover

1. Reset the memory insulator 1  over the installed memory expansion board(s),
ensuring that all edges of the memory insulator are tucked inside the memory
expansion compartment (Figure 5-29).

2. Replace the memory expansion slot cover 2  by placing it flush over the memory
expansion compartment, then sliding it left until it is seated.

3. Secure the memory expansion slot cover to the computer with a memory expansion
slot cover security screw 3  or a standard Torx T-10 screw.

Figure 5-29.  Replacing the Memory Expansion Slot Cover
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5.11  Keyboard Assembly

The keyboard assembly consists of the keyboard, keyboard bezel, and the pointing
device, and is spared as a unit. This assembly must be removed to gain access to the
interior components of the computer.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove any battery pack(s) from the computer (Section 5.7).

3. Turn the computer upside down with the rear panel facing forward.

4. Remove the nine screws from the bottom of the computer (Figure 5-30).

CAUTION:  The two screws removed from the highlighted screw holes are shorter than
the other seven screws. Make sure these shorter screws are installed in the same
locations when replacing the keyboard assembly. Failure to follow this caution
can result in damage to the computer.

Figure 5-30.  Removing the Keyboard Assembly Screws
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5. Turn the computer right side up with the front of the computer facing forward.

6. Open the computer as far as it will open.

NOTE:  With the display open and the battery pack and hard drive removed, the weight
of the display makes the computer susceptible to being easily tipped over.

7. Peel off the keyboard warning label from the keyboard and remove the two screws
securing the keyboard to the computer (Figure 5-31).

Figure 5-31.  Removing the Keyboard Warning Label and Screws
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8. Lift the keyboard assembly straight up and away from the computer (Figure 5-32).

Figure 5-32.  Removing the Keyboard Assembly

Reverse the above procedure to reinstall the keyboard assembly.

IMPORTANT:  A set of keyboard warning labels is included with each keyboard
assembly spare part kit and various other spare part kits and spare parts that require
removal of the keyboard assembly. Select a language from the set and place the label in
the upper right corner of the keyboard assembly. This label contains a warning message
to prevent physical discomfort and harm. This label is essential.
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5.12  Power Supply

The power supply is located in the rear left side of the computer. The power supply
attaches and connects to the system board.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove any battery pack(s) from the computer (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the left rear cover 1  by sliding the cover toward the front of the computer
and lifting it off the power supply (Figure 5-33).

5. Use the connector removal tool to disconnect the power supply cable 2  from the
system board.

6. Remove the two screws that secure the power supply to the system board and the
screw that secures the ground clip to the processor module assembly 3 . Make sure
the ferrite beads on the power supply cable do not obstruct the removal of the
inboard screw.

 NOTE:  Make special note of the alignment and orientation of the ground clip. The
longer horizontal plane should be on top when it is replaced.

Figure 5-33.  Removing the Left Rear Cover and Disconnecting the Power Supply Cable
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7. Position the computer so the rear panel faces forward.

8. Remove the two screws 1  that secure the power supply to the I/O bracket
(Figure 5-34).

9. Position the computer so the front faces forward.

10. Lift up on the front of the power supply 2  and swing it up and away until it clears
the computer.

Figure 5-34.  Removing the Power Supply

Reverse the above procedure to install the power supply.

CAUTION:  Make sure the fan cable is not pinched when installing the power supply.
Also make sure the power supply cable Is tucked away from the battery connector and
battery charging bay. Failure to follow these cautions can result in damage to the fan
and power supply.
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5.13  Fan Assembly

The fan assembly consists of the motorized fan and a rubber mounting sleeve. The fan
assembly is mounted on the left side of the computer and is connected to the
system board.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Use the connnector removal tool to disconnect the cable 1  connecting the fan
assembly to the system board (Figure 5-35).

5. Release the fan assembly from the brackets 2  that secure either side of the assembly
by pulling the brackets apart.

6. Lift the fan assembly out of the computer 3 .

Figure 5-35. Removing the Fan Assembly

Reverse the above procedure to install the fan assembly. When installing it, make sure
the alignment tabs on the sides of the rubber mounting sleeve slide into the slots on the
fan mounting rails on the computer base assembly. Also make sure the fan cable is
routed between the power supply and the base assembly.

IMPORTANT:  When installing the fan, make sure it is oriented with the airflow arrow
(located on the side of the fan) pointing to the outside of the computer.
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5.14  Audio/USB Board

The audio/USB board is located in the right rear area of the computer and connects to
the modem or audio only board. The keyboard assembly must be removed to access the
audio/USB board.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Position the computer so the rear panel faces forward.

5. Remove the two screws on either side of the USB connector (Figure 5-36).

Figure 5-36.  Removing the Audio/USB Board Screws
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6. Position the computer so the front faces forward.

7. Remove the screw that secures the right rear cover to the modem board and remove
the right rear cover 1  (Figure 5-37).

8. Lift up on the front of the audio/USB board 2  until the connector disconnects and
swing the board up and away from the computer.

9. Remove the audio/USB board insulator 3 .

Figure 5-37.  Removing the Audio/USB Board

Reverse the above procedure to install the audio/USB board.

5.15  Modem Board

The modem board is located in the right rear area of the computer and connects to the
audio/USB and system boards. The keyboard assembly and audio/USB board must be
removed to access the modem board.

NOTE:  Computers not equipped with a modem contain an audio only board in the same
location. Removal procedures are the same for the audio only board.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).
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3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Disconnect the display audio cable from the modem board 1  (Figure 5-38).

CAUTION:  The display audio cable and its connector are fragile. Handle the cable by the
stiffener material on the connector and lift the connector straight up. Failure to follow
this caution can result in damage to the cable and connector on the modem/audio only
board.

6. Remove the screw 2  that secures the modem board to the audio assembly bracket.

7. Lift up on the left side of the modem board until the connection to the system board
disconnects. Lift the modem board out of the computer 3 .

Figure 5-38.  Removing the Modem Board

Reverse the above procedure to install the modem board or audio only board.
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5.16  Audio Assembly Bracket

The audio assembly bracket is located in the right rear area of the computer and covers
the PC Card assembly. The audio/USB board and modem board are secured to the audio
assembly bracket.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery pack(s) from the computer (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Remove the modem board (Section 5.15).

6. Remove the three screws 1  that secure the audio assembly bracket to the system
board and the screw 2  that secures the audio assembly bracket to the processor
module assembly (Figure 5-39).

7. Lift the audio assembly bracket out of the computer. Firm pressure is required to
remove it as it is attached to the processor module assembly by a thermal pad.

CAUTION:  To avoid damaging the PC Card assembly, lift the bracket straight up. Failure
to follow this caution can result in damage to the PC Card assembly.

Figure 5-39.  Removing the Audio Assembly Bracket

Reverse the above procedure to install the audio assembly bracket.
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IMPORTANT:  When the audio assembly bracket is removed, the thermal pad 1  that
separates the bracket from the processor module assembly can leave residue on the
underside of the audio assembly bracket 2  and the top of the heat sink on the processor
module assembly 3  (Figure 5-40).

Scrape any residue from both components. Install a new thermal pad on the processor
module assembly 3  before replacing the audio assembly bracket. A new thermal pad is
spared with the processor module assembly and in the Miscellaneous Hardware Kit.

Figure 5-40.  Location of Thermal Pad on the Processor Module Assembly
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CAUTION:  When installing the audio assembly bracket, make sure the auxiliary battery
cable is routed between the modem connector 1  and the audio assembly bracket 2 .
Make sure the cable is not pinched by the screw standoff on the audio assembly bracket
(Figure 5-41).

Figure 5-41.  Routing the Auxiliary Battery Cable
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5.17  Lithium Disc Cell Battery

The lithium disc cell battery is located underneath the audio assembly bracket. The
battery attaches to the system board inside a clip.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Remove the modem board (Section 5.15).

6. Remove the audio assembly bracket (Section 5.16).

7. Use the connector removal tool to push the left edge of the battery to the right and lift
it out of the clip (Figure 5-42).

Figure 5-42.  Removing the Lithium Disc Cell Battery

Reverse the above procedure to install the lithium disc cell battery.
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5.18  Processor Module Assembly

The processor module assembly is located in the center of the computer. It consists of
the processor board, the interposer board (with memory), a heat sink, a heat spreader,
and two ground clips. The assembly attaches to the system board by two multipin
connectors and two screws.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Remove the modem board (Section 5.15).

6. Remove the audio assembly bracket (Section 5.16)
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7. Remove the two screws 1  that secure the processor module assembly to the system
board (Figure 5-43).

8. Lift up on the front of the processor module assembly until the connection to the
system board disconnects 2 . Once disconnected, lift up on the back of the processor
module assembly to remove it.

IMPORTANT:  When removing and replacing the processor module assembly, make sure
the power supply cables are clear from the front left side of the assembly 3 .

Figure 5-43.  Removing the Processor Module Assembly
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Reverse the removal procedure to install the processor module assembly. Before
installing the two screws on the processor module assembly, make sure the connectors
are properly seated.

When replacing the processor module assembly, remove the two ground clips 1  and 2
that are attached to the assembly and retain them for use with the new processor module
assembly (Figure 5-44).

Make note of the alignment and orientation of each ground clip when replacing the
processor module assembly.

CAUTION:  The screws used to secure the ground clips to the processor module
assembly are shorter than the screws used to secure the processor module assembly to
the system board. Do not interchange these screws. Failure to follow this caution can
result in damage to the computer.

Refer to Tables C-5 and C-6 in Appendix C, “Screw Matrix,” for part number and
specification information on these screws.

Figure 5-44.  Processor Module Assembly Ground Clip Locations and Alignment

NOTE:  Refer to Section 5.16, “Audio Assembly Bracket,” for information on replacing
the thermal pad when servicing the processor module assembly.
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5.19  Display Assembly

Removing the Display Assembly
1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Remove the modem board (Section 5.15).

6. Remove the audio assembly bracket (Section 5.16)

7. Remove the processor module assembly (Section 5.18).

8. Position the computer so the front faces forward.
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9. Remove the screw that secures the display video cable connector to the system board
(Figure 5-45).

Figure 5-45.  Removing the Display Video Cable Connector Screws
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10. Grasp the tabs on the display video connector 1  and disconnect the display video
cable from the system board 2  (Figure 5-46).

Figure 5-46.  Disconnecting the Display Video Cable
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11. Disconnect the auxiliary battery cable from the system board (Figure 5-47).

Figure 5-47.  Disconnecting the Auxiliary Battery Cable
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12. Position the computer so the rear panel faces forward.

13. Remove the six screws from the rear panel (Figure 5-48). The four screws on the far
left and right sides of the computer 1  secure the display assembly to the computer.
The two screws in the middle 2  secure the display ground cable and auxiliary battery
assembly to the computer.

NOTE:  The screws that secure the auxiliary battery assembly to the computer base
assembly are shorter than the four screws that secure the display assembly to the base
assembly.

Figure 5-48.  Removing the Display Assembly and Auxiliary Battery Assembly Screws



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

5-54 Removal and Replacement Procedures

14. Position the computer so the front faces forward.

15. Lift the display assembly straight up from the computer (Figure 5-49).

Figure 5-49.  Removing the Display Assembly
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16. Disconnect the auxiliary battery assembly from the display ground cable
(Figure 5-50).

Figure 5-50.  Disconnecting the Auxiliary Battery Assembly from the Display Ground Cable
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Installing the Display Assembly
1. Attach the auxiliary battery assembly to the display ground cable. The tabs on the

ends of the ground cable 1  fit into the slots on the end of the auxiliary battery
bracket 2 ; the pins on the bottom of the bracket 3  fit into the holes on the bottom of
the ground cable 4  (Figure 5-51).

Figure 5-51.  Attaching the Display Ground Cable to the Auxiliary Battery Assembly
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2. Position the display clutches so the display assembly is fully upright when it is
installed in the computer (Figure 5-52).

Figure 5-52.  Proper Position of the Display Clutches
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3. Hold the display assembly approximately one to two inches above the base assembly,
parallel to the computer 1  (Figure 5-53).

4. Roll the auxiliary battery assembly and display ground cable counterclockwise
toward the computer 2  and place the tabs on the auxiliary battery bracket on the
hooks on the base assembly 3 .

Figure 5-53.  Attaching the Display Ground Cable/Auxiliary Battery Assembly to the Computer
Base Assembly

5. Tilt the display assembly upright and position the display clutches in the proper
locations in the base assembly.

6. Position the computer so the rear panel faces forward.

7. Install the two screws that secure the display ground cable and auxiliary battery
assembly to the computer.

8. Install the four screws that secure the display assembly to the base assembly.
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9. Connect the display video cable 1  to the system board and install the screw 2  that
secures the cable to the system board (Figure 5-54).

Figure 5-54.  Connecting the Display Video Cable

10. Position the computer so the front of the computer faces forward.
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11. Route the auxiliary battery cable between the modem connector 1  and the audio
assembly bracket 2  (Figure 5-55).

12. Connect the auxiliary battery cable to the system board.

Figure 5-55.  Connecting the Auxiliary Battery Cable to the System Board
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5.20  PC Card Eject Levers

The PC Card eject levers are located on the right side of the computer.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the audio/USB board (Section 5.14).

5. Remove the modem board (Section 5.15).

6. Remove the audio assembly bracket (Section 5.16).

7. Pull out both PC Card eject levers 1  (Figure 5-56).

8. Lift the PC Card eject levers off their mounting post 2 .

Figure 5-56.  Removing the PC Card Eject Levers
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Installing the PC Card Eject Levers

NOTE:  The top and bottom eject levers are not interchangeable. Take special
precautions to note the proper position of each lever when installing the PC Card
eject levers.

1. Use a narrow flat tool, such as a small flat-blade screwdriver or a “spoojer,” to hold
back the PC Card eject buttons 1  (Figure 5-57).

2. Align the PC Card eject levers with the flush edges of each lever located on the
inside 2 .

3. Place the PC Card eject levers on the mounting post 3 .

Figure 5-57.  Installing the PC Card Eject Levers
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5.21  System Board

Follow these steps to remove the system board:

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the power supply (Section 5.12).

5. Remove the fan assembly (Section 5.13).

6. Remove the audio/USB board (Section 5.14).

7. Remove the modem board (Section 5.15).

8. Remove the audio assembly bracket (Section 5.16).

9. Remove the processor module assembly (Section 5.18).

10. Remove the display assembly (Section 5.19).

11. Remove the hard drive (Section 5.8).

12. Remove the MultiBay device (Section 5.9).
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13. Remove the expansion connector shield by lifting it from the computer base
assembly (Figure 5-58).

Figure 5-58.  Removing the Expansion Connector Shield

Reverse the above procedure to install the expansion connector shield.

CAUTION:  The connector shield must be present to prevent short circuits. Failure to
install the connector shield can result in damage to the computer.
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14. The keyboard connector insulator is attached to the back of the keyboard connector
(Figure 5-59). If a new insulator must be installed, remove the old insulator, remove
the tape backing from the new insulator, and attach the new insulator to the back of
the keyboard connector.

Figure 5-59.  Removing the Keyboard Connector Insulator

Reverse the above procedure to install the keyboard connector insulator.

CAUTION:  The keyboard connector insulator must be present to prevent short circuits.
Failure to install the keyboard connector insulator can result in damage to the computer.

15. Remove the PC Card eject levers (Section 5.20).
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16. Remove the four screws 1  and 2  that secure the system board to the computer base
assembly (Figure 5-60).

NOTE:  Two of the four screws removed in this step are flathead screws 2 . When
installing the system board, these flathead screws must be installed in the front/right
section of the system board.

17. Remove the standoff 3  that secures the system board to the computer base.

Figure 5-60.  Removing the System Board Screws
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18. Position the computer so the rear panel faces forward.

19. Remove the six 3/16-inch screwlocks 1  that secure the system board and I/O bracket
to the CPU base assembly (Figure 5-61).

20. Remove the two 7-millimeter guide bushings 2  that secure the the system board and
I/O bracket to the CPU base assembly.

21. Remove the screw located above the external keyboard/mouse connector 3 .

Figure 5-61.  Removing the System Board Screwlocks and Keyboard/Mouse Connector Screw
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22. Position the computer so the front faces forward.

23. Lift the front of the system board. When the front edge of the system board clears the
base assembly, lift the system board out of the base assembly (Figure 5-62).

24. Remove the system board insulator from the base assembly.

Figure 5-62.  Removing the System Board and Insulator

Reverse the above procedure to install the system board and insulator.

IMPORTANT:  When installing the system board, install and tighten the screwlock on the
left side of the expansion connector first. This aligns the system board to the I/O
bracket. Next, install and tighten the remaining screwlocks and screws. This procedure
ensures proper alignment of the system board and I/O bracket in the computer base
assembly.
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5.22  PC Card Assembly
1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the power supply (Section 5.12).

5. Remove the fan assembly (Section 5.13).

6. Remove the audio/USB board (Section 5.14).

7. Remove the modem board (Section 5.15).

8. Remove the audio assembly bracket (Section 5.16).

9. Remove the processor module assembly (Section 5.18).

10. Remove the display assembly (Section 5.19).

11. Remove the PC Card eject levers (Section 5.20).

12. Remove the system board (Section 5.21).
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13. Turn the system board upside down.

14. Remove the two screws 1  that secure the PC Card assembly to the system board
(Figure 5-63).

15. Lift the left side of the PC Card assembly to disconnect it from the system board 2 .

Figure 5-63.  Removing the PC Card Assembly

Reverse the above procedure to install the PC Card assembly.
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5.23  I/O Bracket

The I/O bracket provides support for the connectors on the rear panel of the computer
and serves as a shield.

1. Prepare the computer for disassembly (Section 5.4).

2. Remove all battery packs (Section 5.7).

3. Remove the keyboard assembly (Section 5.11).

4. Remove the power supply (Section 5.12).

5. Remove the fan assembly (Section 5.13).

6. Remove the audio/USB board (Section 5.14).

7. Remove the modem board (Section 5.15).

8. Remove the audio assembly bracket (Section 5.16).

9. Remove the processor module assembly (Section 5.18).

10. Remove the display assembly (Section 5.19).

11. Remove the PC Card eject levers (Section 5.20).

12. Remove the system board and insulator (Section 5.21).

13. Remove the PC Card assembly (section 5.22).
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14. Lift the back edge of the I/O bracket. When the bracket clears the computer base
assembly, lift it out of the base assembly (Figure 5-64).

Figure 5-64.  Removing the I/O Bracket

Reverse the above procedure to install the I/O bracket.
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Specifications 6-1

Specifications
This chapter provides physical and performance specifications for the:

6.1  Physical and Environmental
Specifications

Table 6-1
Computer

U.S. Metric

Dimensions
Height
Depth
Width

    2.00 in
    9.65 in
  12.60 in

  5.09 cm
24.16 cm
32.05 cm

Weight     8.20 lb   3.72 kg
Standalone (Battery) Power Requirements

Nominal Operating Voltage
Maximum Operating Power
Peak Operating Power

  12 VDC
  15 W
  25 W

AC Adapter Power Requirements
Operating Voltage
Operating Current
Operating Frequency Range
Maximum Transient

  90 - 240 VAC RMS
    0.4 - 0.8 A RMS
  47 to 63 Hz AC
    1kV for 50 ns

Automobile Adapter DC Input Requirements
Operating Voltage
Operating Power

  10 to 24 VDC
  30 to 40 W

Temperature
Operating
Nonoperating

  50 to 104°F
   -4 to 140°F

 10 to 40°C
-20 to 60°C

Relative Humidity (noncondensing)
Operating
Nonoperating (tw = 38.7°C max)

  10 to 90%
    5 to 95% -- 38.7°C Maximum Wet Bulb

Altitude
Operating
Nonoperating

    0 to 10,000 ft
    0 to 30,000 ft

  0 to 3.05 km
  0 to 9.14 km

Shock
Operating
Nonoperating

  10 G, 11 ms, half sine
240 G,   2 ms, half sine

Vibration
Operating
Nonoperating

    0.5 G
    1.5 G

NOTE:  Applicable product safety standards specify thermal limits for plastic surfaces.
The computer operates well within this range of temperatures.
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6.2  Display Specifications

Table 6-2
13.3-inch XGA, CTFT Display

U.S. Metric

Dimensions
Height
Width
Diagonal

  7.98 in
10.64 in
13.30 in

20.28 cm
27.03 cm
33.79 cm

Number of Colors 256, 32K, 64K, 16M

Contrast Ratio 150:1

Brightness 125 CD/M2

Pixel Resolution
Pitch
Format
Configuration

1024 × 768
RGB Stripe

0.264 × 0.264 mm

Backlight Edge Lit, bottom

Character Display 80 × 25

Total Power Consumption 4.0 W
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6.3  Hard Drive Specifications

Table 6-3
Hard Drive

5.0-GB

Capacity per Drive 5.0-GB

Drive Type 65

2.5-Inch Form Factor Yes

Sector Interleave 1:1

Integrated Controller Yes

Physical Configuration
Cylinders
Heads
Bytes per Sector

6975
      8
  137 to 225

Logical Configuration
Cylinders
Heads
Sectors per Track
Bytes per Sector

10592
      15
      63
    512

Buffer Size 512K

Seek Times (Typical, including setting in ms)
Single Track
Average
Full Stroke

  4
12
23

Transfer Rates
Host/Interface (MB/sec)
Media (Mbits/sec)

16.6
60.2 to 98.5
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6.4  Diskette Drive Specifications

Table 6-4
Diskette Drive

Diskette Size
High Density
Low Density

    3.5 inch
    1.44 MB/1.2 MB
720 KB

Light None

Height 0.59 in (15 mm)

Bytes per Sector 512

Sectors per Track
Hight Density
Low Density

18 (1.44 MB)/15 (1.2 MB)
  9

Tracks per Side
High Density
Low Density

80 (1.44 MB)/80 (1.2 MB)
80

Read/Write Heads 2

Average Seek Times
Track-to-Track (high/low)
Average (high/low)
Settling Time
Latency Average

    3 ms
  95 ms
  15 ms
100 ms
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6.5  CD-ROM Drive Specifications

Table 6-5
20X Max CD-ROM Drive

Applicable Disc CD-ROM mode 1, mode 2
CD-Digital Audio
CD-XA mode 2 (Form 1, Form 2)
CD-I mode 2 (Form 1, Form 2)
Photo CD (single/multisession)
CD-I Ready
CD-Bridge
CD-WO (fixed packets only)

Center Hole Diameter 15 mm

Disc Diameter 12 cm, 8 cm

Disc Thickness 1.2 mm

Track Pitch 1.6 µm

Laser
Divergence
Output Power
Type
Wave Length

53.5 ± 1.5 degrees
  0.13 ± 0.1 mw
Semiconducter Laser GaA1As
780nm ± 25nm

Access Time
Random
Full Stroke

< 150 ms
< 600 ms

Audio Output Lever
Line Out
Headphone

0.7 V rms
none

Cache Buffer 256 KB

Data Transfer Rate
Sustained, quad
Sustained, single
Burst
Startup Time

  300 MB/sec
  150 KB/sec
      8.3 MB/sec
< 10 seconds typical

Capacity
Mode 1, 12 cm
Mode 2, 12 cm
8 cm

550 MB
640 MB
180 MB



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

6-6 Specifications

6.6  Battery Pack Specifications

Table 6-6
Lithium Ion Battery Pack

U.S. Metric

Dimensions
Height
Length
Weight

0.92 in
5.44 in
3.46 in

  2.34 cm
13.82 cm
  8.80 cm

Weight 0.89 lb 0.40 kg

Energy
Voltage
Capacity

14.4 V
  2.7 Ah

Environmental Requirements
Operating Temperatures
Charging Temperatures
Recommended Storage Temperatures

No longer than 1 month
No longer than 3 months
No longer than 1 year

50°F to 104°F
50°F to 104°F

32°F to 140°F
32°F to 113°F
32°F to   68°F

 10°C to 40°C
 10°C to 40°C

   0°C to 60°C
   0°C to 45°C
   0°C to 20°C
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6.7  System Interrupts

Table 6-7
System Interrupts

Hardware IRQ System Function

IRQ1 Timer Interrupt

IRQ2 Cascaded

IRQ3 PCMCIA

IRQ4 Modem (COM1)

IRQ5 Audio (default)*

IRQ6 Diskette drive

IRQ7 Parallel

IRQ8 RTC

IRQ9 Infrared

IRQ10 PCMCIA

IRQ11 Network Interface on ArmadaStation/Armada
MiniStation**

IRQ12 Internal Point Stick or External Mouse

IRQ13 Coprocessor (Not available to any peripheral)

IRQ14 IDE Interface (Hard Disk and CD-ROM Drive)

IRQ15 Fixed Disk Drives on the ArmadaStation/Armada
MiniStation

Notes:
PCMCIA cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15.
Either the infrared or the serial port may assert IRQ3 or IRQ4.
  *Default configuration; audio possible configurations are: IRQ5, IRQ7, IRQ9, IRQ10, or none.
**Default configuration; possible configurations for ArmadaStation or Armada MiniStation network interface 

adapter are IRQ9, IRQ10, IRQ11, or none.
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6.8  System DMA

Table 6-8
System DMA

Hardware DMA System Function

DMA0 Available for audio

DMA1 Entertainment Audio (Default; Alternate = DMA0, DMA3, None)

DMA2 Diskette Drive

DMA3 ECP Parallel Port LPT1 (Default; Alternate = DMA 0, none)

DMA4 DMA Controller Cascading (Not available)

DMA5 Available for PC Card

DMA6 Not Assigned

DMA7 Not Assigned

Note:  PC Card controller can use DMA 1, 2, or 5.
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6.9  System I/O Addresses

Table 6-9
System I/O Addresses

I/O Address (Hex) System Function (Shipping Configuration)

000 - 00F DMA Controller no. 1

010 - 01F Unused

020 - 021 Interrupt Controller no. 1

022 - 024 Opti Chipset Configuration registers

025 - 03F Unused

02E - 02F 87334 "Super IO" configuration for CPU

040 - 043 Counter/Timer Registers

044 - 05F Unused

060 Keyboard Controller

061 Port B

062 - 063 Unused

064 Keyboard Controller

065 - 06F Unused

070 - 071 NMI Enable/Real Time Clock

072 - 07F Unused

080 - 08F DMA Page Registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt Controller no. 2

0A2 - 0BF Unused

0C0 - 0DF DMA Controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor Busy Clear/Reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary Fixed Disk Controller

178 - 1EF Unused

1F0 - 1F7 Primary Fixed Disk Controller

1F8 - 200 Unused

201 Joystick (Decoded in ESS1688)

202 - 21F Unused

220 - 22F Entertainment Audio

230 - 26D Unused
Continued
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Table 6-9  Continued

I/O Address (Hex) System Function (Shipping Configuration)

26E - 26 National 87334 "Super IO" Controller in ArmadaStation/Armada
MiniStation

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 ArmadaStation/Armada MiniStation PC Card DMA Selection,
Hard Drive Reset, IDE Select, MultiBay Device Identification

2A8 - 2E7 Unused

2E8 - 2EF Reserved Serial Port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Network Interface in ArmadaStation/Armada MiniStation
(Default; Alternate is 320, 340, or 360h)

320 - 36F Unused

370 - 377 Secondary Floppy Controller (In ArmadaStation/Armada
MiniStation when a floppy is installed in the CPU)

378 - 37F Parallel Port (LPT1/Default)

380 - 387 Unused

388 - 38B FM Synthesizer - OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (Parallel Port/No EPP Support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card Controller in CPU

3E2 - 3E3 PC Card Controller in ArmadaStation/Armada MiniStation

3E8 - 3EF Internal Modem

3F0 - 3F7 "A" Diskette Controller

3F8 - 3FF Serial Port (COM1/Default)

CF8 - CFB PCI Configuration Index Register (PCIDIV0-1)

CFC - CFF PCI Configuration Data Register (PCIDIV0-1)
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6.10  System Memory Map

Table 6-10
System Memory Map

Size Memory Address System Function

640 K 00000000 - 0009FFFF Base Memory

128 K 000A0000 - 000BFFFF Video Memory

  48 K 000C0000 - 000CBFFF Video BIOS

160 K 000C8000 - 000E7FFF Unused

  64 K 000E8000 - 000FFFFF System BIOS

  15 M 00100000 - 00FFFFFF Extended Memory

  58 M 01000000 - 047FFFFF Super Extended Memory

  58 M 04800000 - 07FFFFFF Unused

    2 M 08000000 - 080FFFFF Video Memory (Direct Access)

    4 G 08200000 - FFFEFFFF Unused

   64 K FFFF0000 - FFFFFFFF System BIOS

6.11  Modem Chipset Specifications

Table 6-11
Modem Chipset Specifications

Component Manufacturer Part Number

Primary DSP Lucent 16345T48-AE23-DB

Secondary DSP Lucent 1635T08-BA23-DB

ASIC Lucent VALV34-T-DB

Hybrid Lucent D2560BBL-DT

Controller Motorola MC68LC302PU
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Connector Pin Assignments    A-1

Connector Pin Assignments

Table A-1
Ethernet RJ-11

Connector Pin Signal

6
5

4
3

2
1 7

8

1
2
3
4
5
6
7
8

NC_J3A
NC_J3B
TIP
RING
NC_J3C
NC_J3D
Unused
Unused

Table A-2
Serial Connector

4

98

52

76

1 3

Pin Signal Pin Signal

1 Carrier Detect 6 Data Set Ready
2 Receive Data 7 Ready to Send
3 Transmit Data 8 Clear to Send
4 Data Terminal Ready 9 Ring Indicator
5 Ground

Table A-3
Microphone Jack

Connector Pin Signal

1 2

1
2

Audio in
Ground
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A-2    Connector Pin Assignments

Table A-4
Stereo Speaker/Headphone Jack

Connector Pin Signal

1 2

1
2

Audio out
Ground

Table A-5
Stereo Line-in Jack

Connector Pin Signal

1 2

1
2

Audio in
Ground

Table A-6
Parallel Connector

1234

151617 14

5678910111213

1820 1921222325 24

Pin Signal Pin Signal

  1 Strobe 14 Auto Linefeed
  2 Data Bit 0 15 Error
  3 Data Bit 1 16 Initialize Printer
  4 Data Bit 2 17 Select In
  5 Data Bit 3 18 Ground
  6 Data Bit 4 19 Ground
  7 Data Bit 5 20 Ground
  8 Data Bit 6 21 Ground
  9 Data Bit 7 22 Ground
10 Acknowledge 23 Ground
11 Busy 24 Ground
12 Paper End 25 Ground
13 Select
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Connector Pin Assignments    A-3

Table A-7
Docking Connector

31
61
91

1

120
90
60
30

Pin Signal Pin Signal

  1 EBOXL 34 XA1/R OUT
  2 AGND 35 GND
  3 EBOXS1 36 GND
  4 RED 37 EXPCLK2
  5 AGND 38 +3.3V
  6 GREEN 39 EXPCLK0
  7 AGRD 40 +5V (8051VCC)
  8 BLUE 41 EXPCLK
  9 AGND 42 EBOXS2
10 VSYNC 43 GND
11 HSYNC 44 EBOXL
12 DDC DAT 45 EBOXL /GND
13 DDC CLK 46 SRDY
14 GND 47 EBOXS1 /GND
15 INDEX 48 RI1 EX
16 RDATA 49 GND
17 TRK0 50 SLCT LD0
18 WDATA 51 PE LD1
19 WGATE 52 ACK LD2
20 STEP 53 BUSY LD3
21 DIR 54 GND
22 POWER ON 55 STRB LD4
23 SYS RESET 56 ALF LD5
24 GND 57 INIT LD6
25 DSKCHG 58 SLCTIN LD7
26 +5 V (VDD) 59 GND
27 AUGND 60 PDATA0 LD8
28 XA2/L IN 61 PDATA1 LD9
29 XA3/R IN 62 PDATA2 LD10
30 MID0/MIC IN 63 PDATA3 LD11
31 AUGND 64 GND
32 XA0/L OUT 65 PDATA4 LD12
33 XSD/MIC SN 66 PDATA5 LD13

Continued
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A-4    Connector Pin Assignments

Table A-7  Continued

Pin Signal Pin Signal

  67 PDATA6 LD14 105 AD[16]
  68 PDATA7 LD15 106 GND
  69 GND 107 AD[15]
  70 ERROR LCLK 108 AD[13]
  71 RXD1 LVREQ 109 AD[11]
  72 TXD1 LCREQ 110 AD[09]
  73 RTS1 LEN 111 GND
  74 GND 112 AD[06]
  75 CTS1 LIIC CLK 113 AD[04]
  76 DTR1 LIIC DAT 114 AD[02]
  77 DSR1 EX 115 AD[00]
  78 DCD1 EX 116 GND
  79 12C DATA 117 FRAME
  80 GND 118 TRDY
  81 12C CLK 119 STOP
  82 GND 120 PAR
  83 HDSEL 121 CBE0
  84 GND 122 CBE1
  85 WPROT 123 GND
  86 EBOXS2 /GND 124 KB CLK
  87 ERDY 125 RSVD1/M CTRL2
  88 EBOXL /GND 126 XSC/L OUT SN
  89 FLUSHREQ 127 RSVD2/M OFF HOOK
  90 MEMACK 128 KB DATA
  91 PS2 VCC 129 MGND
  92 SERIRQ 130 STANDBY
  93 PS2 CLK 131 M DRZP
  94 EXPREQ 132 M DRXN
  95 AD[29] 133 VBATT
  96 AD[31] 134 EXPGNT
  97 AD[30] 135 VBATT
  98 AD[28] 136 GND
  99 AD[26] 137 VBATT
100 GND 138 PS2 DATA
101 AD[24] 139 VBATT
102 AD[22] 140 AD[25]
103 AD[20] 141 VBATT
104 AD[18] 142 AD[27]

Continued
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Connector Pin Assignments    A-5

Table A-7  Continued

Pin Signal Pin Signal

143 VBATT 160 CBE3
144 AD[23] 161 CBE2
145 GND 162 IRDY
146 AD[21] 163 DEVSEL
147 AD[19] 164 LOCK
148 AD[17] 165 OERR
149 GND 166 SERR
150 AD[14] 167 GND
151 AD[12] 168 RSVD3
152 AD[10] 169 M 12C CLK
153 AD[08] 170 M 12C DATA
154 GND 171 M RING
155 AD[07] 172 MGND
156 AD[05] 173 M DXTN
157 AD[03] 174 GND
158 AD[01] 175 M DXTP
159 GND 176 MSTRBAT

Table A-8
External Keyboard/Mouse Connector

Connector Pin Signal

KEY

6 5

4 3

2 1

1
2
3
4
5
6

Keyboard/Mouse DATA
Keyboard/Mouse DATA
Ground
+5 VDC
Keyboard/Mouse CLK
Keyboard/Mouse CLK



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

A-6    Connector Pin Assignments

Table A-9
External Monitor Connector

1

6

23

8 7

45

10 KEY

1112131415

Pin Signal Pin Signal

1 Red Analog   9 NC
2 Green Analog 10 Ground
3 Blue Analog 11 NC
4 NC 12 DDC Data
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync
7 Ground 15 DDC Clock
8 Ground
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Appendix  

Power Cord Set Requirements     -1

Power Cord Set
Requirements

3-Conductor Power Cord Set
The wide range input feature of the Armada 7800 Family of Personal Computers
permits it to operate from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set received with the computer meets the requirements for use in the
country where the equipment is purchased.

Power cord sets for use in other countries must meet the requirements of the country
where the computer is used. For more information on power cord set requirements,
contact a Compaq authorized reseller or service provider.

General Requirements
The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 5.00 feet (1.5 m) and a maximum
of 6.50 feet (2.0 m).

2. All power cord sets must be approved by an acceptable accredited agency
responsible for evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC
320 Standard Sheet C13 connector, for mating with appliance inlet on the back of the
computer.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

 -2    Power Cord Set Requirements

Country-Specific
Requirements

3-Conductor Power Cord Set Requirements— By Country
Country Accredited Agency Applicable Note Numbers

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

Norway NEMKO 1

Sweden SEMKO 1

Switzerland SEV 1

United Kingdom BSI 1

United States UL 2

Notes
1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor,  1.0 mm2

conductor size. Power cord set fittings (appliance coupler and wall plug) must bear
the certification mark of the agency responsible for evaluation in the country where
it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor.
The wall plug must be a two-pole grounding type with a NEMA 5-15P (15A, 125V)
or NEMA 6-15P (15A, 250V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a "T" mark and
registration number in accordance with the Japanese Dentori Law. The flexible cord
must be Type VCT or VCTF, 3-conductor, 0.75mm2 conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303
(15A, 125V) configuration.
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Appendix  C

Screw Matrix C-1

Screw Matrix
This appendix contains information for all screws, screwlocks, and bushing guides used
when servicing the Armada 7800 Computer. An illustration appears below each listing
indicating where the hardware is used.

Table C-1

Part Number Description Head Torque Color Qty Section(s) Used

272326-001 Screw, M3.0 × 6.0 T10 4.0 Lb.-in. Black 1 5.10 (memory expansion door
to base assembly)
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C-2 Screw Matrix

Table C-2

Part Number Description Head Torque Color Qty Section(s) Used

144865-006 Screw, M2.5 × 24 T8/Slot 3.0 Lb.-in. Black 7 5.11 (keyboard assembly to
base assembly ➊)

Table C-3

Part Number Description Head Torque Color Qty Section(s) Used

144865-009 Screw, M2.5 ×
17.75

T8/Slot 4.0 Lb.-in. Black 2 5.11 (keyboard assembly to
base assembly ➋)
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Screw Matrix C-3

Table C-4

Part Number Description Head Torque Color Qty Section(s) Used

315724-001 Screw, M2.5 × 5.0 T8/Slot 4.0 Lb.-in. Gold 2

1

1

2

5.11 (keyboard assembly to
base assembly under
keyboard label ➊)

5.14 (audio/USB board and
right rear cover to audio
assembly bracket ➋)

5.15 (modem board to audio
assembly bracket ➌)

5.16 (audio assembly bracket
to standoff ➍ and
processor module
assembly ➎)
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C-4 Screw Matrix

Table C-5

Part Number Description Head Torque Color Qty Section(s) Used

144865-012 Screw, M2.5 × 6.5 T8/Slot 4.0 Lb.-in. Black 4

2

2

1

5.12 (power supply to base
assembly and I/O
bracket ➊)

5.18 (processor module
assembly to base
assembly ➋)

5.19 (auxiliary battery bracket
to base assembly ➌)

5.22 (system board to
I/O bracket over
keyboard connector ➍)

Table C-6

Part Number Description Head Torque Color Qty Section(s) Used

144865-020 Screw, M2.5 × 3.5 T8/Slot 4.0 Lb.-in. Black 2 5.18 (ground clips to processor
module assembly ➎)
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Screw Matrix C-5

Table C-7

Part Number Description Head Torque Color Qty Section(s) Used

144864-018 Screw, M2.5 × 12.0 T8/Slot 4.0 Lb.-in. Green 1 5.19 (display video cable
connector to system board)
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C-6 Screw Matrix

Table C-8

Part Number Description Head Torque Color Qty Section(s) Used

272240-003 Screw, M2.5 × 10.0 T8/Slot 4.0 Lb.-in. Black 4 5.19 (display clutches to base
assembly)
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Screw Matrix C-7

Table C-9

Part Number Description Head Torque Color Qty Section(s) Used

144865-019 Screw, M2.5 × 20.5 T8/Slot 4.0 Lb.-in. Black 2 5.16 (audio assembly bracket
to base assembly ➊)

Table C-10

Part Number Description Head Torque Color Qty Section(s) Used

314884-002 Standoff, 3/16 ×
16.3

3/16” Hex 4.0 Lb.-in. Silver 1 5.16 (audio assembly bracket
to base assembly ➋)
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C-8 Screw Matrix

Table C-11

Part Number Description Head Torque Color Qty Section(s) Used

144864-002 Screw, M2.5 × 5.0 T8/Slot 4.0 Lb.-in. Silver 2 5.21 (System board to base
assembly ➊)

Table C-12

Part Number Description Head Torque Color Qty Section(s) Used

220747-001 Screw, flathead,
custom

T8 4.0 Lb.-in. Red 2 5.21 (System board to base
assembly at MultiBay ➋)
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Screw Matrix C-9

Table C-13

Part Number Description Head Torque Color Qty Section(s) Used

106902-005 Screwlock, 4-40 ×
.312

3/16” 6.0 Lb.-in. Silver 6 5.21 (serial, parallel, and
external monitor
connectors to I/O
bracket ➊)

Table C-14

Part Number Description Head Torque Color Qty Section(s) Used

220508-001 Bushing guide 7mm 6.0 Lb.-in. Silver 2 5.21 (expansion connector to
I/O bracket ➋)
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C-10 Screw Matrix

Table C-15

Part Number Description Head Torque Color Qty Section(s) Used

144863- Screw, M2.0 × 0.40,
flat top

T8/Slot 4.0 Lb.-in. Silver 2 5.22 (PC Card assembly to
system board)
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Index I-1

Index
A
AC power

cord requirements, B-1
Armada 7000 Hard Drive

MultiBay Adapter
illustrated, 3-10
inserting a hard drive, 5-22
inserting into MultiBay, 5-22
option part number, 3-11
spare part number, 3-11

Armada 7800 Illustrated Parts
Map

spare part number, 3-12
Armada 7800 Maintenance &

Service Guide
spare part number, 3-12

ArmadaStation and Armada
MiniStation Illustrated
Parts Map

spare part number, 3-12
ArmadaStation and Armada

MiniStation Maintenance
& Service Guide

spare part number, 3-12
asset management, 1-4
asset tag number, 1-5
audio

assembly bracket
illustrated, 3-2, 3-5
removal, 5-42
thermal pad

replacing, 5-43
only board
illustrated, 3-2
removing, 5-40
spare part number, 3-3

test error codes, 2-16
troubleshooting, 2-21

audio/USB board
illustrated, 3-2
insulator, 5-40
removing, 5-39
spare part number, 3-3

automobile/aircraft adapter,
1-11

cable
spare part number, 3-6

illustrated, 3-6, 3-10
option part number, 3-11
spare part number, 3-6, 3-11

auxiliary battery
cable
connecting, 5-60
disconnecting, 5-52

disconnecting, 5-55
illustrated, 3-2, 3-6, 3-8
installation, 5-56
retainer
illustrated, 3-2, 3-4

spare part number, 3-3, 3-6,
3-9

B
base assembly

illustrated, 3-2
spare part number, 3-3

battery
3-volt Lithium disc cell
spare part number, 3-3

bay
illustrated, 1-12

charger, 1-11
illustrated, 3-6, 3-10

equipment, 1-11
lithium disc cell
replacing, 5-45

pack, 1-11
illustrated, 3-2, 3-6, 3-8,

3-10
inserting into battery bay,

5-15
inserting into MultiBay,

5-16
option part number, 3-11
removing from battery bay,

5-10

removing from MultiBay,
5-12

spare part number, 3-3, 3-6,
3-9, 3-11

specifications, 6-6
troubleshooting, 2-24

power light
illustrated, 1-17

release latch
illustrated, 1-18

Battery Charger, 1-11
option part number, 3-11
spare part number, 3-6, 3-11

beep codes, 2-7
boot sequencing, 2-18

C
cables

handling, 4-2
caps lock

key
illustrated, 1-16

light
illustrated, 1-17

carton & shipping buns kit
spare part number, 3-12

CD-ROM
drive
20X Max

illustrated, 3-7, 3-8, 3-10
option part number, 3-11
spare part number, 3-7,

3-9, 3-11
specifications, 6-5

formats, 1-10
test error codes, 2-16
troubleshooting, 2-26

cellular phone cable
illustrated, 3-10
option part number, 3-11
spare part number, 3-11

checkup
computer, 2-10

Compaq
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I-2    Index

diagnostics, 2-18
utilities, 2-8

components, 1-7
computer

checkup, 2-10
components, 1-7
bottom, 1-18
display, 1-12
front, 1-12
illustrated, 3-2
keyboard, 1-16, 1-17
left side, 1-12
rear panel, 1-14
right side, 1-13
spare part numbers, 3-2

disassembly reference chart,
5-2

disassembly sequence chart,
5-3

disconnecting, 5-7
documentation
spare part numbers, 3-12

features, 1-1
feet, 5-9
logo, 5-8
models, 1-3
options
illustrated, 3-10
option part numbers, 3-11
spare part numbers, 3-11

preparing for disassembly,
5-4

serial number, 5-1
setup, 2-8
undocking, 5-4

computer checkup (TEST),
2-10

error codes, 2-11
computer setup, 2-9, 2-10
configuration management,

1-6
connector

pin assignments, A-1
connectors

handling, 4-2
country kit

spare part number, 3-12

cursor-control
keys
illustrated, 1-16

D
design overview, 1-19
diagnostics

Compaq, 2-18
disassembly reference chart,

5-2
disassembly sequence chart,

5-3
disconnecting computer, 5-7
diskette drive, 1-9

error codes, 2-13
illustrated, 3-7, 3-8
spare part number, 3-7, 3-9
specifications, 6-4
troubleshooting, 2-27

display
assembly, 5-49
installing, 5-56
removing, 5-49

illustrated, 3-2
release latch
illustrated, 1-12

spare part number, 3-2
specifications, 6-2, 6-4
switch
illustrated, 1-16

troubleshooting, 2-36
docking

connector
illustrated, 1-15
pinout, A-3

restraint latch recess
illustrated, 1-18

documentation
spare part numbers, 3-12

E
EasyPoint III pointing device

cap
spare part number, 3-3, 3-9

illustrated, 1-17

electrostatic
damage
preventing, 4-3

discharge
typical voltage levels, 4-6

embedded numeric keypad
illustrated, 1-16

error codes
audio test, 2-16
CD-ROM test, 2-16
Computer Checkup (TEST),

2-11
diskette drive test, 2-13
hard drive test, 2-14
keyboard test, 2-12
memory test, 2-12
parallel printer test, 2-12
pointing device interface

test, 2-16
processor test, 2-11
serial test, 2-13
video test, 2-15

Ethernet RJ-11 jack
pinout, A-1

expansion connector shield
illustrated, 3-2, 3-5
removing, 5-64

external diskette drive
spare part number, 3-7

cable
illustrated, 3-7
spare part number, 3-7

illustrated, 3-7
kit
illustrated, 3-10
option part number, 3-11
spare part number, 3-11

external monitor
connector
illustrated, 1-15

troubleshooting, 2-36
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Index I-3

F
F1 through F12 function keys

illustrated, 1-16
fan

illustrated, 1-12, 3-2
removing, 5-38
spare part number, 3-3

fatal error
beep codes, 2-7
messages, 2-6

fault management, 1-5
alerts, 1-5

features
computer, 1-1

feet, 5-9
Fn key

illustrated, 1-16

G
grounding

methods, 4-5

H
hard drive, 1-9

5.0-GB
illustrated, 3-2, 3-7, 3-8,

3-10
option part number, 3-11
spare part number, 3-3, 3-7,

3-9, 3-11
bay
illustrated, 1-12

inserting into Armada 7000
Hard Drive MultiBay
Adapter, 5-22

inserting into hard drive bay,
5-20

inserting into MultiBay, 5-22
light
illustrated, 1-17

release latch
illustrated, 1-18

removing from hard drive
bay, 5-17

removing from MultiBay,
5-23

security screw slot
illustrated, 1-18

specifications, 6-3
test error codes, 2-14
tray
illustrated, 3-2, 3-4

troubleshooting, 2-28
hardware installation

troubleshooting, 2-29
headset

illustrated, 3-10
option part number, 3-11
spare part number, 3-11

I
I/O addresses, 6-9
I/O bracket

removing, 5-71
illustrated parts catalog, 3-1
infrared

port
illustrated, 1-15

troubleshooting, 2-30
initialization

default settings, 2-18
INSPECT (View System

Information), 2-17
intelligent manageability, 1-4
items that ship with the

computer
illustrated, 3-8
spare part numbers, 3-9

J
jacks

illustrated, 1-14

K
keyboard

assembly
spare part number, 3-3

connector
illustrated, 1-15
pinout, A-5

connector shield
removing, 5-65

illustrated, 3-2
removing, 5-33
test error codes, 2-12

L
Li-ion

battery pack, 1-11
illustrated, 3-6, 3-8, 3-10
spare part number, 3-6

logo, 5-8

M
mass storage devices, 1-9

illustrated, 3-7
spare part numbers, 3-7

memory
expansion board
16-MB

illustrated, 3-10
option part number, 3-11
spare part number, 3-11

32-MB
illustrated, 3-10
option part number, 3-11
spare part number, 3-3,

3-11
64-MB

illustrated, 3-10
option part number, 3-11
spare part number, 3-11

illustrated, 3-2
inserting, 5-31
removing, 5-30

expansion slot cover
illustrated, 1-18, 3-2, 3-4
removing, 5-29
replacing, 5-32

map, 6-11
options, 1-8
test error codes, 2-12

messages
fatal error, 2-6
warning, 2-5

microphone
illustrated, 1-12
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I-4    Index

jack
illustrated, 1-14
pinout, A-1

miscellaneous
spare part numbers, 3-12

miscellaneous hardware kit
components, 3-5
illustrated, 3-5
spare part number, 3-3, 3-5

miscellaneous plastics kit
components, 3-4
illustrated, 3-4
spare part number, 3-3, 3-4

miscellaneous screws kit
spare part number, 3-3, 3-12

models
computer, 1-3

modem
board
illustrated, 3-2
spare part number, 3-3

cable
illustrated, 3-8
spare part number, 3-9

chipset specifications, 6-11
removing, 5-40
troubleshooting, 2-31

monitor
connector
pinout, A-6

troubleshooting, 2-36
mouse

buttons
illustrated, 1-17

connector
illustrated, 1-15
pinout, A-5

MultiBay
devices
inserting, 5-27
removing, 5-24

illustrated, 1-12
light
illustrated, 1-17

release latch
illustrated, 1-18

security screw slot
illustrated, 1-18

weight saver
illustrated, 3-8
spare part number, 3-9

N
numeric lock

key
illustrated, 1-16

light
illustrated, 1-17

O
options

illustrated, 3-10
option part numbers, 3-11
spare part numbers, 3-11

P
packaging

precautions, 4-3
page down

key
illustrated, 1-16

page up
key
illustrated, 1-16

parallel
connector
illustrated, 1-15
pinout, A-2

port
test error codes, 2-12

password
clearing, 2-3

PC Card
assembly
illustrated, 3-2
removing, 5-69
spare part number, 3-3

eject lever
illustrated, 1-13, 3-2, 3-4
installing, 5-62
removing, 5-61

slots
illustrated, 1-13

troubleshooting, 2-34

plastic parts
handling, 4-1

pointing device
interface test error codes,

2-16
portable video conferencing

kit
illustrated, 3-10
option part number, 3-11
spare part number, 3-11

ports
default settings, 2-18

POST (Power-On Self-Test),
2-4

POST error messages, 2-4
power

cord
connector

illustrated, 1-15
illustrated, 3-6, 3-8
set requirements, B-1
spare part number, 3-6, 3-9

default settings, 2-19
equipment
illustrated, 3-6
spare part numbers, 3-6

light
illustrated, 1-17

supply
cables, 5-47
removing, 5-36
spare part number, 3-3

supply assembly
illustrated, 3-2

switch
illustrated, 1-16

troubleshooting, 2-35
Power-On Self-Test (POST),

2-4
preparing for disassembly, 5-4
processor

module assembly
ground clips, 5-48
illustrated, 3-2
removing, 5-46
screws

illustrated, 3-5
test error codes, 2-11
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processor board module
assembly

spare part number, 3-3
programmable keys

illustrated, 1-16

R
rear cover

left
illustrated, 3-2, 3-4

right
illustrated, 3-2, 3-4

removal and replacement
preliminaries, 4-1

return kit
spare part number, 3-12

RJ-11 modem jack
illustrated, 1-15

S
screen

troubleshooting, 2-36
screw

matrix, C-1
scroll lock

key
illustrated, 1-16

light
illustrated, 1-17

security
default settings, 2-19
kit
illustrated, 3-8
spare part number, 3-9

management, 1-6
slot
illustrated, 1-13

serial
connector
illustrated, 1-15
pinout, A-1

port
test error codes, 2-13

serial number, xii
location, 1-18, 5-1

service considerations, 4-1

setup
computer, 2-8

slipcase
illustrated, 3-8
spare part number, 3-9

specifications, 6-1
battery pack, 6-6
CD-ROM
drive

20X Max, 6-5
diskette drive, 6-4
display, 6-2, 6-4
DMA, 6-8
hard drive, 6-3
I/O addresses, 6-9
interrupts, 6-7
memory map, 6-11
modem chipset, 6-11

SpeedPaq Cellular PC Card
kit

illustrated, 3-10
option part number, 3-11
spare part number, 3-11

stereo
line-in
jack

illustrated, 1-14
pinout, A-2

speaker/headphone
jack

illustrated, 1-14
pinout, A-2

speakers
illustrated, 1-12

SuperDisc LS-120 drive
illustrated, 3-7, 3-10
option part number, 3-11
spare part number, 3-7, 3-11

suspend
button
illustrated, 1-16

light
illustrated, 1-17

system
DMA, 6-8
I/O address, 6-9
interrupts, 6-7, 6-11
memory map, 6-11

system board, 1-19
illustrated, 3-2
removing, 5-63
spare part number, 3-3

T
technician notes, xi
telephone

cable
illustrated, 3-8
spare part number, 3-9

TEST (computer checkup),
2-10

tilt feet
illustrated, 1-12

tool
kit
spare part number, 3-12

required for service, 4-1
transporting

precautions, 4-3
troubleshooting, 2-1

audio, 2-21
battery pack, 2-24
CD-ROM
drive, 2-26

checklist, 2-20
diskette drive, 2-27
external monitor, 2-36
hard drive, 2-28
hardware installation, 2-29
infrared, 2-30
modem, 2-31
PC Card, 2-34
power, 2-35
preliminary steps, 2-2
screen, 2-36
universal serial bus, 2-38
USB, 2-38
without diagnostics, 2-20

twenty-five-pin modem
connector
illustrated, 1-13
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I-6    Index

U
undocking computer, 5-4
universal serial bus

connector
illustrated, 1-14

troubleshooting, 2-38
USB

connector
illustrated, 1-14

troubleshooting, 2-38
utilities

Compaq, 2-8

V
vents

illustrated, 1-16
video

test error codes, 2-15
View System Information

(INSPECT), 2-17
volume control

illustrated, 1-16

W
warning messages, 2-5
workstation

precautions, 4-4
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